WINTOTAL V5 USER GUIDE

THIS IS A CLASS 1 DOCUMENT WHICH IS NONCONFIDENTIAL.

The information contained within this document is the property of TE Connectivity. It is supplied in confidence and the commercial security of the contents must be maintained. It must not be used for any purpose other than that for which it is supplied nor may any information contained in it be disclosed to unauthorised persons. It must not be reproduced in whole or in part without obtaining written permission from TE Connectivity (TE).

While TE has made every reasonable effort to ensure the accuracy of the information in this catalog, TE does not guarantee that it is error free, nor does TE make any other representation, warranty or guarantee that the information is accurate, correct, reliable or current. TE reserves the right to make any adjustments to the information contained herein at any time without notice. TE expressly disclaims all implied warranties regarding the information contained herein, including, but not limited to, any implied warranties of merchantability or fitness for a particular purpose. The dimensions in this catalog are for reference purposes only and are subject to change without notice. Specifications are subject to change without notice. Consult TE for the latest dimensions and design specifications.

*Trademark. TE Connectivity, TE connectivity (logo), and TE (logo) are trademarks. Other logos, product and/or company names may be trademarks of their respective owners.
## Table of Contents

1. **INTRODUCTION** ........................................................................................................................................ 8

2. **WINTOTAL OVERVIEW** .......................................................................................................................... 8

   2.1. WinTotal .................................................................................................................................................. 8
   2.2. What's New ............................................................................................................................................. 9
       2.2.1. v4.9.00 to v5.0.00 ........................................................................................................................... 9
       2.2.1.1. System Requirements ............................................................................................................... 9
       2.2.1.2. Installation ................................................................................................................................. 9
       2.2.1.3. Licensing ................................................................................................................................. 9
       2.2.1.4. Graphical Interface ............................................................................................................... 10
       2.2.1.5. Data Structure ....................................................................................................................... 10
       2.2.1.6. Import ...................................................................................................................................... 10
       2.2.1.7. Database Printing ................................................................................................................. 10
       2.2.1.8. Add Product ............................................................................................................................ 10
       2.2.1.9. Delete Product ........................................................................................................................ 10
       2.2.1.10. User Defined Layout ............................................................................................................ 10
       2.2.1.11. Design New Products .......................................................................................................... 11
       2.2.1.12. Advanced Label Editing ....................................................................................................... 11
       2.2.1.13. New Set ................................................................................................................................ 11
       2.2.1.14. Print ....................................................................................................................................... 11
       2.2.1.15. Advanced Print ..................................................................................................................... 11
       2.2.1.16. Paper Report ......................................................................................................................... 11
       2.2.2. V5.0.00 to v5.2.00 ....................................................................................................................... 12
       2.2.2.1. New Features ........................................................................................................................... 12
       2.2.3. V5.2.00 to v5.3.00 ....................................................................................................................... 13
       2.2.3.1. New Features ........................................................................................................................... 13
       2.2.4. V5.3.00 to v5.4.00 ....................................................................................................................... 14
       2.2.4.1. New Features ........................................................................................................................... 14
   2.3. System Requirement .............................................................................................................................. 15

3. **LICENCE AGREEMENT** .......................................................................................................................... 16

   3.1. Licence Agreement Guidelines ............................................................................................................. 17
       3.1.1. Scenario 1: One computer and one or more printers ............................................................... 17
       3.1.2. Scenario 2: Multiple computers that print to one or more printers ......................................... 17
       3.1.3. Scenario 3: Multiple computers but only one computer prints to one or more printers .......... 17
   3.2. Software Licensing ............................................................................................................................... 18
       3.2.1. Demo Mode ................................................................................................................................. 18
       3.2.2. Software Key Registration ......................................................................................................... 18
       3.2.3. Screen Options ........................................................................................................................... 18
       3.2.3.1. Activation Server .................................................................................................................. 18
       3.2.3.2. Online Registration .............................................................................................................. 19
       3.2.3.3. Print Registration Data ......................................................................................................... 19
       3.2.3.4. Save Registration Data ......................................................................................................... 19
       3.2.4. Hardware Key Registration ......................................................................................................... 20

4. **GETTING STARTED** .............................................................................................................................. 21

   4.1. Quick Start ......................................................................................................................................... 21
   4.2. Screen Overview ................................................................................................................................. 22
   4.3. Menus and Toolbars ......................................................................................................................... 23
       4.3.1. Menus ........................................................................................................................................ 23
       4.3.2. Toolbar ..................................................................................................................................... 23
       4.3.2.1. Screen Options ..................................................................................................................... 24
       4.3.3. Set and Product Selection ........................................................................................................... 25
       4.3.3.1. Selected Set ............................................................................................................................. 25
4.3.3.2. Selected Product ................................................................. 25
4.3.4. Legend & Legend Data .............................................................. 27
4.3.5. Keypad ............................................................................... 27
4.3.6. Mouse Operation ................................................................. 28
4.4. Printer & Product Support ......................................................... 30
4.4.1. Printer Support .................................................................. 30
4.4.2. Multiple Application Port Printing ......................................... 31
4.4.3. Printer Calibration ................................................................. 32
4.5. Getting Data from External Source ............................................... 33
4.5.1. ASCII Text Files .................................................................. 33
4.5.2. XMT Files .......................................................................... 34
4.5.2.1. XMT Colour Codes .......................................................... 35
4.5.2.2. XMT Font Codes .............................................................. 35
4.5.3. Windows Database ............................................................... 35
4.5.3.1. Import ........................................................................... 36
4.5.3.2. Database Printing ............................................................ 36
4.5.3.3. Troubleshooting ............................................................... 36
4.5.4. Database Connection Setup .................................................... 36
4.5.4.1. Select Data Source ........................................................... 37
4.5.4.2. Select Tables ................................................................ 38
4.5.4.3. Select Columns .............................................................. 39
4.5.4.4. Select Filter .................................................................. 40
4.5.4.5. Preview of Selected Tables and Columns ............................. 40
4.5.4.6. Save Data and Connection Name ....................................... 41
4.6. Font Selection ....................................................................... 42
4.6.1. Font Recommendations ....................................................... 42
4.6.2. Printer Fonts ..................................................................... 43
4.6.2.1. Printer Fonts Available ................................................... 43
4.6.3. Windows Fonts .................................................................. 44
4.6.3.1. Arial ............................................................................ 44
4.6.3.2. Courier New ................................................................. 44
4.7. Serialisation ........................................................................ 45
4.7.1. Fixed Serialisation ............................................................... 45
4.7.2. Auto-numbering Product ...................................................... 45
4.7.3. Numerical ....................................................................... 45
4.7.4. Alpha ............................................................................ 45
4.7.4.1. Base ........................................................................... 45
4.7.4.2. Increment ................................................................. 45
4.7.4.3. Qty - Quantity ............................................................. 46
4.7.4.4. Group ...................................................................... 46
4.8. Data Entry Order .................................................................. 46
4.9. System Administration ............................................................ 46
4.9.1. Data Management/Backup ................................................... 46
4.9.1.1. User Access Rights ......................................................... 47
4.9.1.2. Data Files (Sets) ............................................................ 47
4.9.1.3. WDF File Format .......................................................... 47
4.9.1.4. SET File Format .......................................................... 47
4.9.1.5. Custom Products ......................................................... 47
4.9.1.6. User-defined Layout ..................................................... 48
4.9.1.7. Configuration Files ....................................................... 48
4.9.1.8. Windows Database Connection ..................................... 48
4.9.2. User Access Control ............................................................ 48
5. PROGRAM OVERVIEW ........................................................................ 49
5.1. File .................................................................................. 49
5.1.1. New Set ........................................................................ 50
5.1.1.1. Screen Options ........................................................... 50
5.1.2. Open Set ....................................................................... 50
5.1.2.1. Screen Options ........................................................... 51
5.1.3.  Save As .......................................................... 51
5.1.3.1.  Screen Options ............................................. 51
5.1.4.  Change Set Description ..................................... 52
5.1.5.  Delete Set ...................................................... 52
5.1.6.  Import .......................................................... 52
5.1.6.1.  ASCII Text .................................................... 52
5.1.6.1.1.  Screen Options ........................................... 52
5.1.6.1.2.  ANSI Formats ............................................. 53
5.1.6.1.3.  Skip First Line .......................................... 53
5.1.6.1.4.  Import Order: Down-Across .......................... 53
5.1.6.1.5.  One Field per Line ..................................... 53
5.1.6.1.6.  Ignore Line Breaks ...................................... 53
5.1.6.1.7.  Field Separator ......................................... 53
5.1.6.1.8.  Quantity Field No ...................................... 53
5.1.6.1.9.  Physical Lines per Logical ......................... 54
5.1.6.1.10.  Output Set Section .................................... 54
5.1.6.1.11.  Append Data ............................................. 54
5.1.6.1.12.  Insert Data ............................................. 54
5.1.6.1.13.  Preview before Import ............................... 54
5.1.6.1.14.  Open Set after Import ............................... 54
5.1.6.1.15.  Import to Default Data Directory ................. 55
5.1.6.1.16.  Preview ................................................... 55
5.1.6.1.17.  Import ..................................................... 55
5.1.6.1.18.  Save ...................................................... 55
5.1.6.2.  XMT .......................................................... 55
5.1.6.2.1.  Screen Options ........................................... 55
5.1.6.2.2.  ANSI Format ............................................. 56
5.1.6.2.3.  Import Order: Down-Across .......................... 56
5.1.6.2.4.  Horizontal Align ...................................... 56
5.1.6.2.5.  Vertical Align ........................................... 56
5.1.6.2.6.  Value of font in XMT file given is physical CPI 56
5.1.6.2.7.  Use this font ............................................. 56
5.1.6.2.8.  Bold ....................................................... 56
5.1.6.2.9.  6 and 9 Underlined ................................... 56
5.1.6.2.10.  Import into Product ................................ 56
5.1.6.2.11.  User Defined Layout ................................. 56
5.1.6.2.12.  Output Set Section ................................... 57
5.1.6.2.13.  Open Set After Import ............................. 57
5.1.6.2.14.  Import to Default Data Directory ................. 57
5.1.6.2.15.  Import ..................................................... 57
5.1.6.2.16.  Save ...................................................... 57
5.1.6.3.  Windows Database ........................................ 57
5.1.6.3.1.  Screen Options ........................................... 57
5.1.6.3.2.  ANSI Format ............................................. 58
5.1.6.3.3.  Import Order: Down-Across .......................... 58
5.1.6.3.4.  Format Number Field ................................ 58
5.1.6.3.5.  No. of Decimals ........................................ 58
5.1.6.3.6.  Show Database Fields ............................... 58
5.1.6.3.7.  Quantity Field No ...................................... 58
5.1.6.3.8.  Records per Marker ................................... 58
5.1.6.3.9.  Output Set Section .................................... 59
5.1.6.3.10.  Append Data ............................................. 59
5.1.6.3.11.  Insert Data ............................................. 59
5.1.6.3.12.  Preview before Import ............................... 59
5.1.6.3.13.  Open Set After Import ............................. 59
5.1.6.3.14.  Import to Default Data Directory ................. 59
5.1.6.3.15.  Preview ................................................... 60
5.1.6.3.16.  Import ..................................................... 60
5.1.6.3.17.  Save ...................................................... 60
5.1.7. Database Printing.......................................................................................................................... 60
5.1.7.1. Screen Options .......................................................................................................................... 60
5.1.7.2. Product Section ......................................................................................................................... 61
5.1.7.3. Database Section ....................................................................................................................... 61
5.1.7.3.1. ANSI Format ......................................................................................................................... 61
5.1.7.3.2. Import Order: Down-Across ................................................................................................. 61
5.1.7.3.3. Format Number Field .......................................................................................................... 61
5.1.7.3.4. No. of Decimals .................................................................................................................... 61
5.1.7.3.5. Show Database Fields .......................................................................................................... 61
5.1.7.3.6. Quantity Field No. .............................................................................................................. 62
5.1.7.3.7. Records per Marker ............................................................................................................. 62
5.1.7.4. Preview ........................................................................................................................................ 62
5.1.7.5. Print ............................................................................................................................................ 62
5.1.8. Data Conversion ............................................................................................................................ 62
5.1.8.1. WinTotal Internal ..................................................................................................................... 62
5.1.8.2. Input File Types ....................................................................................................................... 62
5.1.8.2.1. Import Unmatched Products ............................................................................................... 62
5.1.8.2.2. Source Directory ................................................................................................................ 63
5.1.8.2.3. Existing Files ....................................................................................................................... 63
5.1.8.2.4. Destination Directory ........................................................................................................ 63
5.1.8.2.5. Destination Files ................................................................................................................ 63
5.1.8.2.6. Convert All Files ............................................................................................................... 63
5.1.8.2.7. Convert Selected Files ...................................................................................................... 63
5.1.8.3. Cross Reference List ............................................................................................................... 63
5.1.8.3.1. Screen Options ................................................................................................................... 63
5.1.8.4. Export ....................................................................................................................................... 64
5.1.8.4.1. Screen Options ................................................................................................................... 64
5.1.8.4.2. Header Information on Line 1 Section ................................................................................. 64
5.1.8.4.3. Output Format Section ....................................................................................................... 65
5.1.8.4.4. Legends to Export Section ................................................................................................. 65
5.1.8.5. Log Off ..................................................................................................................................... 66
5.1.8.6. Exit ........................................................................................................................................... 66
5.2. Product ............................................................................................................................................. 66
5.2.1. Add Product ............................................................................................................................... 67
5.2.1.1. Screen Options ....................................................................................................................... 67
5.2.1.1.1. Select Product .................................................................................................................. 67
5.2.1.1.2. Attributes ......................................................................................................................... 67
5.2.1.1.3. Dimensions ....................................................................................................................... 68
5.2.1.1.4. Auto Numbering Products ............................................................................................... 69
5.2.1.2. User Defined Layout ............................................................................................................. 69
5.2.1.2.1. Auto Numbering Products ............................................................................................. 69
5.2.2. Change Product ......................................................................................................................... 70
5.2.3. Delete Product ........................................................................................................................... 70
5.2.4. List Standard Product ............................................................................................................... 71
5.2.5. User Defined Layouts ............................................................................................................... 71
5.2.6. Screen Options ........................................................................................................................... 72
5.2.6.1. User Defined Layout Options ............................................................................................... 72
5.2.7. Design New Products ................................................................................................................. 72
5.2.7.1. Screen Options ....................................................................................................................... 73
5.2.7.1.1. Select Standard Product ................................................................................................ 73
5.2.8. Design New Products – Edit Product ........................................................................................ 73
5.2.8.1. Dimensions ........................................................................................................................... 73
5.2.8.1.1. Screen Options .................................................................................................................. 73
5.2.8.2. Appearance ............................................................................................................................ 74
5.2.8.2.1. Screen Options .................................................................................................................. 75
5.2.8.3. Printers ....................................................................................................................................... 75
5.2.8.3.1. Screen Options .................................................................................................................. 75
5.2.9. Advanced Label Fields ............................................................................................................. 75
5.2.9.1. Screen Options ....................................................................................................................... 76
| 5.2.10. | Advanced Label Editing .......................................................... | 76 |
| 5.3. | Data Entry ................................................................................. | 76 |
| 5.3.1. | Add Data.................................................................................... | 77 |
| 5.3.1.1. | Screen Options ......................................................................... | 77 |
| 5.3.1.2. | Quantity - Qty .......................................................................... | 78 |
| 5.3.1.3. | Occurs ....................................................................................... | 78 |
| 5.3.1.4. | Keypad ...................................................................................... | 78 |
| 5.3.2. | Change Data .............................................................................. | 79 |
| 5.3.3. | Insert ........................................................................................ | 79 |
| 5.3.4. | Delete ......................................................................................... | 80 |
| 5.3.5. | Copy .......................................................................................... | 80 |
| 5.3.6. | Find ........................................................................................... | 80 |
| 5.3.7. | Replace ...................................................................................... | 81 |
| 5.3.8. | Move .......................................................................................... | 81 |
| 5.3.9. | View Serialisations ................................................................... | 81 |
| 5.3.10. | Constants ............................................................................... | 82 |
| 5.4. | Print .......................................................................................... | 82 |
| 5.4.1. | Print ......................................................................................... | 82 |
| 5.4.1.1. | Screen Options ......................................................................... | 83 |
| 5.4.1.1.1. | Positioning .............................................................................. | 83 |
| 5.4.1.1.2. | Legend Selection ..................................................................... | 83 |
| 5.4.1.1.3. | Port .......................................................................................... | 84 |
| 5.4.1.1.4. | Copies ....................................................................................... | 84 |
| 5.4.1.1.5. | Options .................................................................................... | 84 |
| 5.4.1.1.6. | Sensor ..................................................................................... | 86 |
| 5.4.2. | Manual Print ............................................................................. | 86 |
| 5.4.2.1. | Screen Options ......................................................................... | 87 |
| 5.4.3. | Advanced Print ....................................................................... | 87 |
| 5.4.3.1. | Screen Options ......................................................................... | 87 |
| 5.4.3.1.1. | Selection Method .................................................................... | 87 |
| 5.4.3.1.2. | Print Queue ............................................................................ | 88 |
| 5.4.3.1.3. | Selection .................................................................................. | 88 |
| 5.4.4. | Print Preview ........................................................................... | 89 |
| 5.4.4.1. | Screen Options ......................................................................... | 90 |
| 5.4.5. | Paper Report ........................................................................... | 90 |
| 5.4.5.1. | Screen Options ......................................................................... | 90 |
| 5.4.6. | Print Log .................................................................................. | 91 |
| 5.5. | Preferences ............................................................................. | 91 |
| 5.5.1. | System Setup ........................................................................ | 91 |
| 5.5.1.1. | Printers ................................................................................... | 91 |
| 5.5.1.1.1. | Screen Options ....................................................................... | 92 |
| 5.5.1.1.2. | Assign Products .................................................................... | 93 |
| 5.5.1.1.3. | Assign Directory .................................................................... | 94 |
| 5.5.1.2. | Directories .............................................................................. | 94 |
| 5.5.1.2.1. | Screen Options .................................................................... | 94 |
| 5.5.1.3. | Options .................................................................................... | 94 |
| 5.5.1.3.1. | Screen Options .................................................................... | 95 |
| 5.5.1.4. | View ........................................................................................ | 96 |
| 5.5.1.4.1. | Screen Options .................................................................... | 96 |
| 5.5.1.5. | User Access ........................................................................... | 96 |
| 5.5.1.6. | XMT Import Server ................................................................ | 96 |
| 5.5.1.6.1. | Screen Options .................................................................... | 97 |
| 5.5.2. | Application look ..................................................................... | 97 |
| 5.5.3. | Zoom In .................................................................................... | 97 |
| 5.5.4. | Zoom Out .................................................................................. | 97 |
| 5.6. | Help ......................................................................................... | 98 |
| 5.6.1. | Help Topics ............................................................................ | 98 |
| 5.6.2. | About ........................................................................................ | 98 |
| 5.6.3. | Show Mouse Operation Help .................................................. | 98 |
5.6.4. Software Registration

6. TE CONNECTIVITY TECHNICAL SUPPORT
1. INTRODUCTION

This document is a partial reproduction of the Help file contained within WinTotal v5. As the WinTotal v5 document has active cross-references and embedded examples these have been omitted.

For full information on WinTotal v5 refer to the WinTotal v5 Help Topics.

Figure 1

2. WINTOTAL OVERVIEW

2.1. WinTotal

The WinTotal software by TE Connectivity is a Cable Identification and Labelling program. This powerful package makes printing TE Connectivity Identification products in an industrial environment simple by using pre-loaded templates.

WinTotal features a highly graphical user interface to simplify operator training and minimise errors. All functions can be easily accessed using Windows' pull-down menus or the toolbar. Many of the commonly used functions can also be accessed with on-screen buttons.

Data can be manually typed into the program or, using WinTotal's Import function, data from ASCII text files and databases can be imported, e.g. Microsoft Access and Excel. Customised templates can also be created for new products. Custom-specific layouts can also be created where dimensions and data formatting can be specified. The Windows environment gives access to a huge array of font options, including non-English fonts such as Chinese, Japanese and Hebrew (when used with appropriate operating systems or add-on software).

WinTotal allows simple importing and manipulation of graphics, logos and barcodes. WinTotal will Print TE Connectivity Identification products on all TE Connectivity (TE) recommended Printers using its own Printer drivers. It also allows the use of standard Windows drivers. Mark quality and permanence cannot be guaranteed when non-TE-tested printers and ribbons are used.

WARNING: Make a back-up copy of all data files. Back-up copies of data should be made regularly. It is especially important to make a duplicate copy of existing data before manipulating those data in a new software package. Please see the Data Management/Backup topic for more information on files to back up.
2.2. What's New

For information on what has changed please select the relevant topic.

- v4.9.00 to v5.0.00
- v5.0.00 to v5.2.00
- v5.2.00 to v5.3.00
- v5.3.00 to v5.4.00

2.2.1. v4.9.00 to v5.0.00

Below is the list of what is new from v4.9.00 to v5.0.00

2.2.1.1. System Requirements

The support for Windows 95, 98, ME and NT has been removed.

The following printers have also been removed as they are no longer supplied by TE Connectivity. If you wish to use these printers you must use an older version than this one.

- 2000Plus Obsolete and no longer supported
- AMT Obsolete and no longer supported
- AM6310 Obsolete and no longer supported
- Critchley Thermal Obsolete and no longer supported
- Epson 1520 Obsolete and no longer supported
- Epson FX (9 pin) Obsolete and no longer supported
- Lexmark 2390 Obsolete and no longer supported
- Oki (24 pin) Obsolete and no longer supported
- RJS Model 260 Obsolete and no longer supported
- Sato CL408 Obsolete and no longer supported
- Sato CL412 Obsolete and no longer supported
- Sato M8450 Obsolete and no longer supported
- Sato GT424e Obsolete and no longer supported
- TMS101TT Use the T208M model as this is identical
- TMS2000T Obsolete and no longer supported
- TMS-QLS2001 Use the T612M DS model as this is identical.
- Zebra 105S Use the T308S model as this is identical.
- Zebra 140xi Use the T408M model as this is identical.
- Zebra Stripe Use the T308S model as this is identical.

2.2.1.2. Installation

New multi-lingual installation program.

2.2.1.3. Licensing

New driverless Hardware Key (Dongle) is now supported. Older Hardware Keys will not work on this version. A new one must be purchased from TE or one of its distributors.

New Serial Number format for registration via a serial number. Older Serial numbers beginning with 0301- will not work on this version. A new one must be purchased from TE or one of its distributors.

New Activation Server option for direct activation without the need for the user to enter the unlock code.
2.2.1.4. Graphical Interface

New red icon supporting the latest icon formats and sizes.
New Toolbar design with larger, clearer images.
New Selected Product list box that can be customised.
New Zoom-in and Zoom-out options.
New Print Preview option to show preview before printing. Serialisations will be expanded with this feature.
New screen designs for all screens.
Documentation.
New help file with more information.
Some texts have been changed in the program to be clearer on functions.

2.2.1.5. Data Structure

New WDF single-file format, allowing double clicking on the WDF file to open WinTotal. See the Data Management/Back-up topic.

New single-file User Defined Layouts file structure called WUP. See the Data Management/Back-up topic.

2.2.1.6. Import

New layout - advanced options can now be hidden or disabled based on user level access. See the Import and User Access topic.

New Preview option to allow previewing the Import before importing. See the Import topic.

2.2.1.7. Database Printing

New feature allowing automatic Import and Print, direct from databases without saving the data in WinTotal. See the Database Printing topic.

2.2.1.8. Add Product

New Rotation field option for 90 rotation steps. See the Add Product topic.

New option for Continuous Family Products to specify the Occurs and Overlap dimensions. See the Add Product topic.

New option called Auto Numbering Product. This is a feature that allows a counter Legend to be created that updates after printing so the next Print job will start from the next number. See the Add Product and Serialisations topics.

User Defined Layouts with attached labels can no longer select alignment options in this screen, as they are not applied.

2.2.1.9. Delete Product

New screen layout to delete multiple Products. See the Delete topic.

2.2.1.10. User Defined Layout

New screen layout. See the User Defined Layouts topic.

New file format with support to Import and Export layouts. See the Data Management/Back-up topic.
New option to allow a created layout name to be changed. See the User Defined Layouts topic.

New option called Default Lines Per Product which limits the number of lines allowed per product, as in the Add Product screen.

2.2.1.11. Design New Products

New screen layout. See the Design New Products topic.

New features - Top Margin and Left Margin, WYSIWYG layouts and printer parameters. See the Design New Products topic.

2.2.1.12. Advanced Label Editing

Access to unsupported features is now blocked to prevent users making configuration changes that are not supported. See the Advanced Label Editing topic.

2.2.1.13. New Set

New options: Copy Previous Legend Line and Copy 1st Line to All Lines. See the Add Data topic.

2.2.1.14. Print

New layout - advanced options can now be hidden or disabled based on user level access. See the Print and User Access topic.

Speed and Density can now be selected from the Print screen. See the Print topic.

Print Mode options can now be selected from the Print screen. See the Print topic.

Sensor parameters can now be selected from the Print screen. See the Print topic.

2.2.1.15. Advanced Print

New screen layout. See the Advanced Print topic.

New buttons for Print Queue ordering. See the Advanced Print topic.

2.2.1.16. Paper Report

The Paper Report can now print to a Windows Printer. See the Paper Report topic.

2.2.1.17. System Setup

The System 90 and System 6/HSI Printer configuration is now simplified into one Default Printer. See the Printers topic.

New Assign Printer screen with tree structure. See the Printers topic.

New options to specify Database Printing and Graphics Directory locations. See the Directories topic.

Language selection is now located in the Options tab.

New options for mm and inches and the default file format are now in the Options tab.

The new Selected Product list box can now be configured in the View tab.
Passwords are now configured in the User Access tab.

New sub levels for User Access can be customised if required.

2.2.2. V5.0.00 to v5.2.00

Below is the list of what is new from v5.0.00 to v5.2.00

2.2.2.1. New Features

<table>
<thead>
<tr>
<th>New Language Support</th>
<th>Chinese language support is now implemented.</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Printer.</td>
<td>The T200 Label Printer is now available in the Printers tab of the System Setup screen.</td>
</tr>
<tr>
<td>Graphical Interface.</td>
<td>Folder browse buttons now open folder browse dialogs not the previous file browse dialogs.</td>
</tr>
<tr>
<td>Printing Feature - All products.</td>
<td>The option Stop After First Marker Is Printed has been implemented to remove the option to print only the first marker. This is useful if multiple users send print jobs to a network printer. It prevents users printing in between the first marker and the rest of the markers. This is configured in the Options tab of the System Setup screen. The same option can be changed in the Print screen also, but it will be reset each time to the setting in the Options tab.</td>
</tr>
<tr>
<td>Printing Feature - Continuous Sleeve products.</td>
<td>The option Do not feed blank sleeves after printing Continuous Sleeves has been implemented to prevent blank sleeves being fed out of the printer on continuous sleeve products. This is configured in the Options tab of the System Setup screen.</td>
</tr>
<tr>
<td>Bug Fixes:</td>
<td>LMS9000. The LMS9000 did not support the new WDF format - this is now resolved.</td>
</tr>
<tr>
<td>Graphical Interface.</td>
<td>The WYSIWYG layout for the following label types showed tractor feed holes - this is now resolved. RMK-A4, LE, TP Tape, TTP and Card products.</td>
</tr>
<tr>
<td>Cutting/Perforating</td>
<td>TE3124 and T3112 printers allowed cutting and perforating of label products. The Every option did not work - this is now resolved.</td>
</tr>
<tr>
<td></td>
<td>T6112DS printer allowed Perforate in Batch mode. This combination is not supported. Now the Perforate option is disabled if the Batch mode is selected.</td>
</tr>
<tr>
<td>Printing Feature - Continuous Sleeve products</td>
<td>The option Do not feed blank sleeves after printing continuous sleeves has been implemented to prevent blank sleeves being fed out of the printer on continuous sleeve products. This is configured in the Options tab of the System Setup screen.</td>
</tr>
</tbody>
</table>

1 Chinese will only display on a Chinese Windows machine.
Advanced Printer Setup

T200 Defaults

The T200 printer; as default, selected the Rotate Back Side 180 option ON in the Enable Print Parameters option in the Advanced Printer Setup. It is now set to be OFF as default.

T6112DS Printer

The T6112DS navigated the lines in the wrong order when editing double-sided multiple-line products. This is now resolved.

When images were placed on the product they would move to the rear side after printing. This is now resolved.

Continuous Products

Continuous products did not calculate the Max Characters Per Field correctly. This is now resolved.

Templates

SBP templates were listed incorrectly in the Advanced Product Setting screen. This is now resolved.

Passwords

Passwords were not being read correctly, which meant that users could not log in to WinTotal. This is now resolved.

2.2.3. V5.2.00 to v5.3.00

Below is the list of what is new from v5.2.00 to v5.3.00

2.2.3.1. New Features

Printer.

T200 Ident printer is now enabled.

Products.

CM-NMX and WM-SCE products added.

Design New Products.

The Design New Products screen now asks users if they wish to load settings from a Standard Product. See the Design New Products topic for more information.

TE3112 and TE3124.

The back-feed option is now implemented for these printers to support continuous sleeve printing.

T6112DS.

Opening sets created on the T6112DS printer on TE3112 and TE3124 printers now prompts the user to accept the change. This allows the template to be converted correctly from a single to a double-sided product.

Constants.

When in data entry mode a new button called Constants allows the constant window to be displayed.

Bug Fixes:

Data Conversion

XMT files were not importing correctly using the data conversion program.

T208M

On multi-lined products if no data were present on a line a space character was inserted over another line.

T2000CT, TE3112 and TE3123 Perforating

Perforating in Batch mode is not supported by these printers and has now been removed.

T2000CT reverse order

Printing selected markers in reverse order missed the last marker.
User Defined Layouts
Rotated 90- and 270-scored products were not created correctly.

Continuous Sleeves
The Max Characters Per Field was not calculating correctly.

2.2.4. V5.3.00 to v5.4.00

Below is the list of what is new from v5.3.00 to v5.4.00

2.2.4.1. New Features

Windows 8
v5.4.00 now supports Windows 8. For more information see the System Requirements topic.

System Requirement
The support for Windows 2000 has been removed.

Product Changes
WM-SCE now allows the Rotation option to be selected.

New Products.
E4 product has been added.

D-SCE-S2C products have been added

TMS-SCE and TMS-SCE-2X have been added to reflect the products current labelling.

Language Support.
Korean language support is now implemented

Turkish language support is now implemented

Bug Fixes:

Product Changes
RMK6-WM products did not allow the correct number of characters to be added to it

Mirror Previous Field
The Mirror Previous Field command missed the last characters.

Revers Print Order
The Reverse Print Order command was not saved.

Double Sided
The Double Sided command was not saved with the product for some printers.

Cutting
Cutting in Batch mode was not working.
The Cut options were missing the Enable Print Parameters screen

Advanced Print
The Stop After First Marker Is Printed option was not functioning when using Advanced Print.

Database
Support for Excel sheets with comma in the sheet name or column name is now allowed

---

2 Korean will only display on a Korean Windows machine.
2.3. **System Requirement**

**Computer:** IBM-compatible PC

**Processor:** 1GHz or higher 32bit (x86) or 64bit (x64)

**Operating system:** Windows XP SP3, XP, Vista, 7 and 8 (32bit or 64bit)
Windows Server 2003, 2008 and 2012 (32bit or 64bit)

**Screen Resolution:** 1024 x 768 pixels

**Disk space required:** 80Mb
3. LICENCE AGREEMENT

Tyco Electronics WinTotal Licence Agreement

Please read this Licence Agreement carefully before installing the software. By installing the software you confirm your agreement to all the terms and conditions listed in this Licence Agreement regarding your company’s use of the Tyco Electronics Software Programme entitled WinTotal.

This is a legal Agreement between you, the end user, and Tyco Electronics Corporation (Tyco Electronics). BY INSTALLING THIS SOFTWARE YOU ARE AGREEING TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT DOWNLOAD THE SOFTWARE.

1. GRANT OF LICENCE

WinTotal is licensed, not sold, to you for use only under this licence, and Tyco Electronics reserves any rights not expressly granted to you. Tyco Electronics grants to you, the end user, the right to use this copy, including written materials if any, of the WinTotal programme at the location, company and address, to which Tyco Electronics issued this copy of WinTotal. WinTotal is owned by Tyco Electronics and is protected by U.S. copyright laws and international treaty provisions. You agree not to alter, merge, duplicate, decompile, or reverse engineer, copy for other locations, or otherwise make this software available to any person or entity outside this location. All copies made by you are subject to the terms and conditions of this Agreement.

2. OTHER RESTRICTIONS

• You may not rent or lease WinTotal to anyone.
• You agree to notify Tyco Electronics promptly if "bugs" or seemingly incorrect or anomalous results are discovered or produced by the use of WinTotal.
• You agree that WinTotal, including written materials if any, may be modified or updated by Tyco Electronics at any time, and you agree to use any updated version of WinTotal after you are notified of such modifications or updates.
• By installing the software, you acknowledge that you have read and understood the Tyco Electronics disclaimer of Warranty and Limitation of Liability, set forth below.
• You agree to use reasonable efforts to protect against the unauthorised copying and use of WinTotal by others.

3. DISCLAIMER OF WARRANTY

THE WinTotal PROGRAM AND ACCOMPANYING WRITTEN MATERIALS ARE PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE WinTotal PROGRAMME IS ASSUMED BY YOU. TYCO ELECTRONICS DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN WinTotal WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF WinTotal WILL BE UNINTERRUPTED OR ERROR FREE, OR THAT PROGRAMME DEFECTS WILL BE CORRECTED.

4. LIMITED WARRANTY-MEDIA

THE MEDIUM ON WHICH THE SOFTWARE IS ENCODED IS WARRANTED TO BE FREE FROM DEFECTS IN MATERIAL AND WORKMANSHIP UNDER NORMAL USE FOR A PERIOD OF SIXTY (60) DAYS FROM THE DATE OF DELIVERY TO YOU AS EVIDENCED BY A COPY OF YOUR RECEIPT. THE ENTIRE LIABILITY OF TYCO ELECTRONICS AND YOUR EXCLUSIVE REMEDY IF THE MEDIUM IS DEFECTIVE SHALL BE THE REPLACEMENT OF THE SOFTWARE.

5. EXCLUSION OF ALL OTHER WARRANTIES

EXCEPT AS EXPRESSLY PROVIDED ABOVE, TYCO ELECTRONICS DISCLAIMS ALL WARRANTIES, EITHER EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PURPOSE, EVEN IF TYCO ELECTRONICS HAS BEEN ADVISED OF SUCH PURPOSE. THIS AGREEMENT GIVES YOU THE SPECIFIC LEGAL RIGHTS. SOME COUNTRIES DO NOT ALLOW THE EXCLUSION OF WARRANTIES, SO THAT THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

6. LIMITATION OF LIABILITY

TYCO ELECTRONICS SHALL NOT BE LIABLE FOR ANY LOSS, DAMAGE, OR DELAY DURING SHIPMENT OR FOR ANY LOSS OF PROFITS, LOSS OF USE, INTERRUPTION OF BUSINESS, NOR FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY KIND WHATSOEVER UNDER THIS AGREEMENT OR OTHERWISE, WHETHER OR NOT TYCO ELECTRONICS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

7. TERMINATION

This Licence will automatically terminate without notice from Tyco Electronics if you fail to comply with any term or condition of this Agreement. You agree, upon such termination, to return WinTotal or destroy it along with any backup or other copies in your possession.

8. COMPLETE AGREEMENT

This Agreement constitutes the sole and complete understanding between the parties with respect to WinTotal and its use, and may not be varied except in writing signed by an authorised signatory of Tyco Electronics. You agree that you may not rely on any representations concerning WinTotal to the extent they vary from this Agreement, and such representations, if any, will neither add to nor vary the terms of this Agreement.

9. CHOICE OF LAWS

This Agreement is governed by the laws of State of New York.

10. ASSIGNMENT

You may neither assign any right nor obligation under this Agreement and any attempted assignment or delegation shall be void.

11. INVALID PROVISIONS

If any of the provisions of this Agreement are invalid under any applicable statute or rule of law, they are to that extent deemed omitted.
3.1. Licence Agreement Guidelines

Each purchased copy of WinTotal entitles the user to one licence. Please see the WinTotal Licence Agreement for full details.

A licence is issued in the form of a serial number or Hardware Key (dongle).

They key points of the licence agreement with reference to multiple installations are:

- Tyco Electronics agrees that the LICENSEE may copy parts of the product for back-up purposes and that LICENSEE may install copies of the product onto multiple design computers.
- LICENSEE agrees to purchase from Tyco Electronics a separate licensed copy of the product for installation onto each computer attached to a printer or printers.

The result of these points gives different options for multiple-computer installations that are described in the scenarios below.

3.1.1. Scenario 1: One computer and one or more printers

WinTotal can be installed and registered once. WinTotal allows for two different computers to be registered using one serial number. This is to cover upgrades, loss, damaged or replaced computers, NOT multiple installations (this is in breach of the Licence Agreement). Once two different computers have been registered no further registration can take place (unless authorised from TE Connectivity Product Management).

3.1.2. Scenario 2: Multiple computers that print to one or more printers

If multiple computers print to one or more printers, then a separate licence for each computer is required. Alternatively, a dongle version of WinTotal can be supplied. The dongle can then be plugged into an unregistered version of WinTotal allowing that computer to have full functionality while the dongle is attached.

3.1.3. Scenario 3: Multiple computers but only one computer prints to one or more printers

In this scenario only one licence is required. This licence is for the computer that prints. Any other computers (design computers) can use an unregistered version of WinTotal. Unregistered versions of WinTotal have full functionality but do not print correctly.
3.2. Software Licensing

WinTotal is copy protected to prevent piracy. The software needs to be registered to be fully functional.

Registration can be done in two ways.

- Software key registration
- Hardware key registration (dongle)

When a copy of WinTotal is purchased it is supplied with either a serial number or Hardware Key supplied within the case.

The serial number will be a 5x5 digit code, e.g. XXXXX-XXXXX-XXXXX-XXXXX-XXXXX. The Hardware Key will be capable of being connected via a USB port. For more information see the topic that is relevant for your installation.

- Software Key Registration
- Hardware Key Registration

If neither of these processes is used then the software will allow 21 days or 100 times use (whichever comes first) of full access. After 21 days or 100 times the software will revert to Demo Mode.

3.2.1. Demo Mode

This mode allows WinTotal to work fully with the exception of printing. In this mode all text will be scrambled when printing.

3.2.2. Software Key Registration

If a serial number was supplied with WinTotal it should be a 5x5 digit code, e.g. XXXXX-XXXXX-XXXXX-XXXXX-XXXXX.

If it is a code beginning with 0301 then this is for older versions of WinTotal and is not compatible with version 5.

Without a registered software or Hardware Key, the software registration screen will be displayed.

The terms of the licence allow only one registered copy of WinTotal for each purchased licence. See the Licence Agreement and Licence Agreement Guidelines for more information.

Enter the customer information with a valid e-mail address. This will be used as the confirmation address for the registration details. Please enter as much data as possible, as these may be needed to provide support in the future. Enter the serial number supplied with the software.

There are then four different ways to register.

3.2.3. Screen Options

3.2.3.1. Activation Server

If WinTotal can connect to the Activation Server then only this button will be available. When selected this will connect to the server, retrieve the unlock code and, if all data are valid, register the program automatically.

If WinTotal cannot connect to the Activation Server then the registration screen will show different options. Three different methods of registration can be used.
3.2.3.2. Online Registration

You must have a valid Internet connection for this option. It will automatically transfer the data in your registration form to one of the selected internet pages and give an unlock code. If the computer where WinTotal is installed has no internet connection then the following options will help to register the program. You will still need access to the internet somewhere to complete the registration.

3.2.3.3. Print Registration Data

This will allow the registration details to be printed to any Windows printer available on your system.

This print-out can then be taken to any computer with internet access and the data on the form entered into the web address (which is also printed).

3.2.3.4. Save Registration Data

This option saves your registration details to a file. This file can then be transferred to disk or network. If the file is opened on a computer with a valid internet connection then the same web page as the Online Registration mode will be displayed giving you the unlock code.

Once registered please make a note of the unlock code (in red). The unlock code should then be entered into the unlock code box.

If you have entered the data correctly then the Continue in DEMO Mode button will change to Register. Click this button to register WinTotal.

Once registered, a confirmation e-mail with the unlock code will be sent to the e-mail used in the customer information section.

If you have no internet access either:

E-mail the file created using the Save Registration Data to your Dealer or TE Connectivity Technical Support, or:

Fax the printed registration data created using the Print Registration Data option to your Dealer or TE Connectivity Technical Support.
3.2.4. Hardware Key Registration

If a USB Hardware Key (dongle) was supplied with WinTotal then this key is the valid WinTotal licence. Whatever computer has this key inserted into it will enable the full functionality of WinTotal. If removed, the program will revert to Demo Mode.

The Hardware Key should look like the image below. If it does not then it is not compatible with this version of WinTotal.

![USB Hardware Key (dongle)](image)

Figure 2 - USB Hardware Key (dongle)

For the Hardware Key to function, please insert the key and wait for the driver to be automatically installed by Microsoft Windows. When completed WinTotal can be launched.
4. GETTING STARTED

The following topics are available to give an overview of the WinTotal software.

- Quick Start - This will show how to enter data and print quickly.
- Screen Overview - This shows the main screen and the key parts used in operating WinTotal.
- Mouse Operation - This will show the mouse click options available within WinTotal.
- Printer/Product Compatibility List - This will show the printers, printer functions, fonts and compatible products supported by WinTotal.
- Getting Data from External Sources - This will explain the different options to retrieve data from external files/databases and to print the data from WinTotal.
- Serialisations - This will explain how serialisations (counters) can be configured.
- Data Entry Order - This will explain the different options available for the order data to be entered into WinTotal.
- System Administration - This will explain the File System used by WinTotal, back-up recommendations and User Access control.

4.1 Quick Start

STEP #1 - Press the New Set button to create a user file.

STEP #2 - Press the Add Product button to select the product and printing details.

STEP #3 - Press the Add Data button and type in the legend information to be printed on the markers.

STEP #4 - Press the Print button to print the data onto the markers.
4.2. Screen Overview

The WinTotal main screen is divided into the following sections:

1. **Menus and Toolbar**
2. **Selected Set and Selected Product**
3. **Legend and Legend Data**
4. **Keypad**
4.3. Menus and Toolbars

The Menus and Toolbar section is where all commands used in WinTotal can be accessed.

4.3.1. Menus

The following menus are available:

- File – where files can be opened, saved and exported.
- Product – where the Product can be created, changed or deleted.
- Data Entry – where the data in a Product can be created, changed or deleted.
- Print – where all commands that Print are accessed.
- Preferences – where all system configurations, including printers, directories and user rights are accessed.
- Help – where the help file and about screen are accessed.

4.3.2. Toolbar

The standard toolbar has some of the main functions used in WinTotal:

The toolbar can be switched on and off in the View tab of the System Setup screen.
4.3.2.1. Screen Options

- New Set
- Open Set
- Save As
- Import
- Database Printing
- Add Product
- Change Product
- Add Data
- Change Data
- Print
- Print Preview
- Advanced Print
- Manual Print
- Advanced Label Editing
- System Setup
- Zoom Out
- Zoom In
- Help
4.3.3. Set and Product Selection

This section contains two list boxes for selecting created sets and products.

![Image of Set and Product Selection](image)

**Figure 4**

4.3.3.1. Selected Set

The Selected Set list box is used to select the current Set to be opened.

When clicked the list box will expand showing all available Sets. Selecting one of them will make this the current Set to be used.

Only Sets in the current Data Directory will be available.

The current Directory is show at the top of the screen along with the Selected Set.

To select a different Directory the New Set command can be used to browse to a new location.

Any new Sets that are created will automatically be added to this list box when they are created.

For more information about Sets see the Data Management/Back-up topic.

4.3.3.2. Selected Product

The Selected Product list box is used to select the Product to be opened with the Selected Set.

Within a Set up to 100 different unique Products can be created and selected.

When clicked the list box will expand, showing all available Products. Selecting one of them will make this
the current Product to be used.

Only Products within the current Selected Set will be available.

The order in which the list box is sorted as default is the order in which the products are added. This can be temporarily sorted by any available heading by clicking on it.

The list box displays the following information as default.

- Name – this is the product name.
- Lines – this is the number of data lines created on the product.
- Size – this will show the width, then height of the product.
- Font – this will show the font used in the product.
- Printer – this will show the printer used in the product.
- Colour – this will show the colour of the product as text; the product is always shown in colour.
- Markers – this will show the quantity of markers (rows of labels or sleeve) within the product.

Additional options are:

- Length – this shows the length of any continuous product that is selected.
- CPI – this shows the characters-per-inch value of the font used in the product.
- Double-sided – this will display Yes or No to show if a double-sided product is selected.
- Bold – this shows Yes or No to determine if the Bold option for a font is selected.
- H. Align – this shows either Top, Centre or Bottom to show the horizontal alignment of the lines of data.
- V. Align – this shows either Top, Centre or Bottom to show the vertical alignment of the lines of data.
- Height – this shows the height of the product.
- Width – this shows the width of the product.
- Rotation – this shows either 0, 90, 180 or 270 to show the rotation of the lines of data

These can be configured via the View tab in the System Setup screen.
4.3.4. Legend & Legend Data

The Legend and Legend Data section contains the data for the *Selected Product* in the *Selected Set*.

![Figure 5](image)

This section has three column headers.

Legend # - this is the legend number. The Legend # is automatically generated and is used in various parts of the program to search, replace, copy, insert, delete and print data based upon the Legend # or Legend # range.

Legend Data – this is where the WYSIWYG representation of the Legend and its data are shown.

Qty – this is where the quantity of a Legend can be displayed.

4.3.5. Keypad

The keypad is a section containing key functions as large, easy-access buttons.

The following functions are available for quick access:

- New Set
- Open Set
- Add Product
- Manual Print
- Add Data
- Change Data
- Print Preview
- Print
- Exit

When in the Add Data or Change Data modes, the keypad changes to Edit mode.

See the keypad section of the *Add Data* topic or more information.
4.3.6. Mouse Operation

The following mouse functions are available:

- Left click on a marker to select or deselect a Legend to work with. A selected Legend is displayed with a box around it (Legend No. 2 in the Figure 4).

![Figure 6](image)

- Left click in the Qty column to change the quantity of the selected Legend.
- Left click on any of the Legend # numbers will select all markers. Figure 5.

![Figure 7](image)

- Right clicking in any area of the Legend Data section will deselect all markers.
- Double right click on a field to enter the Advanced Label Editing field screen. Figure 6
Figure 8
4.4. Printer & Product Support

WinTotal uses its own built-in printer drivers. A generic text-only driver for the required Printer Port is all this is required to print via the Windows Spooler.

The following topics are available:

Printer Support – this shows the available printers in WinTotal.
Multiple Application Port Printing (MAPP) – this describes the MAPP function to assign Products and directories to specific printers.
Printer Calibration – this describes what a printer calibration is and which printers require it and when.

4.4.1. Printer Support

The following printers are available in WinTotal. An overview of their specification and WinTotal-customisable options can be seen by selecting the corresponding model.

<table>
<thead>
<tr>
<th>Name</th>
<th>Printing Technology</th>
<th>Resolution</th>
<th>Primary Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cab A4+300</td>
<td>Thermal transfer</td>
<td>12dpm/300dpi</td>
<td>Sleeve and label printer</td>
</tr>
<tr>
<td>Epson LQ</td>
<td>Dot matrix</td>
<td>24pin</td>
<td></td>
</tr>
<tr>
<td>ITS BTT02</td>
<td>Thermal transfer</td>
<td>12dpm/300dpi</td>
<td>Card printer</td>
</tr>
<tr>
<td>LMS9000</td>
<td>Laser engraving</td>
<td>N/A</td>
<td>Sleeve and label engraving</td>
</tr>
<tr>
<td>T200 Ident</td>
<td>Thermal transfer</td>
<td>12dpm/300dpi</td>
<td>Sleeve and label printer</td>
</tr>
<tr>
<td>T200 label</td>
<td>Thermal transfer</td>
<td>8dpn/200dpi</td>
<td>Label printer</td>
</tr>
<tr>
<td>T2000CT</td>
<td>Thermal transfer</td>
<td>12dpm/300dpi</td>
<td>Continuous sleeve printer</td>
</tr>
<tr>
<td>T208M</td>
<td>Thermal transfer</td>
<td>8dpn/200dpi</td>
<td>Sleeve and label printer</td>
</tr>
<tr>
<td>T208M-New</td>
<td>Thermal transfer</td>
<td>8dpn/200dpi</td>
<td>Sleeve and label printer</td>
</tr>
<tr>
<td>T212M</td>
<td>Thermal transfer</td>
<td>12dpn/300dpi</td>
<td>Sleeve and label printer</td>
</tr>
<tr>
<td>T212M-New</td>
<td>Thermal transfer</td>
<td>12dpn/300dpi</td>
<td>Sleeve and label printer</td>
</tr>
<tr>
<td>T308S</td>
<td>Thermal transfer</td>
<td>8dpn/200dpi</td>
<td>Label printer</td>
</tr>
<tr>
<td>T312M</td>
<td>Thermal transfer</td>
<td>12dpn/300dpi</td>
<td>Sleeve and label printer</td>
</tr>
<tr>
<td>T312S</td>
<td>Thermal transfer</td>
<td>12dpn/300dpi</td>
<td>Label printer</td>
</tr>
<tr>
<td>T312Z</td>
<td>Thermal transfer</td>
<td>12dpn/300dpi</td>
<td>Sleeve and label printer</td>
</tr>
<tr>
<td>T408M</td>
<td>Thermal transfer</td>
<td>8dpn/200dpi</td>
<td>Sleeve and label printer</td>
</tr>
<tr>
<td>T412S</td>
<td>Thermal transfer</td>
<td>12dpn/300dpi</td>
<td>Label printer</td>
</tr>
<tr>
<td>T424S</td>
<td>Thermal transfer</td>
<td>24dpn/600dpi</td>
<td>Double-sided sleeve printer</td>
</tr>
<tr>
<td>T6112DS</td>
<td>Thermal transfer</td>
<td>12dpn/300dpi</td>
<td>Sleeve and label printer</td>
</tr>
<tr>
<td>T612M DS</td>
<td>Thermal transfer</td>
<td>12dpn/300dpi</td>
<td>Sleeve and label printer</td>
</tr>
<tr>
<td>TE3112</td>
<td>Thermal transfer</td>
<td>12dpn/300dpi</td>
<td>Sleeve and label printer</td>
</tr>
<tr>
<td>TE3124</td>
<td>Thermal transfer</td>
<td>24dpn/600dpi</td>
<td>System 90 sleeve printer</td>
</tr>
<tr>
<td>Wheel 10 and above</td>
<td>Daisy Wheel Impact</td>
<td>Depends on Daisy Wheel</td>
<td></td>
</tr>
<tr>
<td>Wheel 3, 5 and 6</td>
<td>Daisy Wheel Impact</td>
<td>Depends on Daisy Wheel</td>
<td></td>
</tr>
<tr>
<td>Wheelprinter E</td>
<td>Daisy Wheel Impact</td>
<td>Depends on Daisy Wheel</td>
<td></td>
</tr>
<tr>
<td>Zebra 170xi</td>
<td>Thermal transfer</td>
<td>8dpn/200dpi</td>
<td>6”-wide label printer</td>
</tr>
</tbody>
</table>

Table 1
4.4.2. Multiple Application Port Printing

Multiple-application Port Printing (MAPP) is the term used where different Products or Data Directory can be assigned to print to a specific printer.

The options available to configure a MAPP system are infinite and its requirements will vary from user to user.

For example: A user has the following printer and wishes to always print the corresponding Products on that printer.

<table>
<thead>
<tr>
<th>No</th>
<th>Printer</th>
<th>Port</th>
<th>Products to be printed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TE3124</td>
<td>USB001</td>
<td>All SCE 1/4-2.00 Yellow sleeves that are not Double Sided + any non defined Products.</td>
</tr>
<tr>
<td>2</td>
<td>T200 Ident</td>
<td>USB002</td>
<td>SCE 1/8-2.00 White sleeves that are not Double Sided. SCE 1/8-2.00 Yellow sleeves that are not Double Sided.</td>
</tr>
<tr>
<td>3</td>
<td>T6112DS</td>
<td>USB003</td>
<td>All SCE Sleeve Products that are Double Sided</td>
</tr>
</tbody>
</table>

Table 2

To make the above combination work configuration in the Printers tab of the System Setup screen should be made as in Figure 7.

With this configuration the user would automatically get the right data sent to the correct Printer.
4.4.3. Printer Calibration

This process is often required by Thermal Transfer printers before a product can be successfully printed.

The calibration process often measures the product and configures internal values according to this measurement.

To perform a calibration the printer must be correctly loaded with ribbon and product and not display any error messages.

Calibration should always be done under the following conditions:

1. If the correct print position cannot be achieved,
2. If product, size, colour or material type has changed.
3. If the printer has been used by other software programs.

The table below shows which printers require calibration.

<table>
<thead>
<tr>
<th>Model</th>
<th>Calibration Required</th>
<th>Recommended Calibration Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAB A4 + 300</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>ITS BTT-02 Card</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>T200 Idnt</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>T200 Label</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>T2000CT</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>T208M</td>
<td>Yes</td>
<td>Calibration Button in Print screen</td>
</tr>
<tr>
<td>T208M-NEW</td>
<td>Yes</td>
<td>Calibration Button in Print screen</td>
</tr>
<tr>
<td>T212M</td>
<td>Yes</td>
<td>Calibration Button in Print screen</td>
</tr>
<tr>
<td>T212M-NEW</td>
<td>Yes</td>
<td>Calibration Button in Print screen</td>
</tr>
<tr>
<td>T312M</td>
<td>Yes</td>
<td>Calibration Button in Print screen</td>
</tr>
<tr>
<td>T312S</td>
<td>Yes</td>
<td>Calibration Button in Print screen</td>
</tr>
<tr>
<td>T312Z</td>
<td>Yes</td>
<td>Calibration Button in Print screen</td>
</tr>
<tr>
<td>T408M</td>
<td>Yes</td>
<td>Calibration Button in Print screen</td>
</tr>
<tr>
<td>T412S</td>
<td>Yes</td>
<td>Calibration Button in Print screen</td>
</tr>
<tr>
<td>T424S</td>
<td>Yes</td>
<td>Calibration Button in Print screen</td>
</tr>
<tr>
<td>T6112DS</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>T612M DS</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>TE3112</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>TE3124</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Zebra 170xi</td>
<td>Yes</td>
<td>Calibration Button in Print screen</td>
</tr>
</tbody>
</table>

Table 3
4.5. Getting Data from External Source

If the data to be printed from WinTotal exist in another source they can, in most cases, be accessed directly from WinTotal.

Importing
This is when data are taken from an external file/data source and imported into WinTotal. These data are then stored for future use and printing.

Live Printing
This is similar to importing but no data are stored in WinTotal. The data are retrieved from the external file/data source, printed and then deleted. This process ensures that the latest data from the source are always printed.

Three different data types can be accessed from WinTotal, some of which are used in Importing and Live Printing methods.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Example File</th>
<th>Imported</th>
<th>Live Printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII Text Files</td>
<td>Data and optional quantity details can be used</td>
<td>TXT, CSV</td>
<td>Yes, using Import option</td>
<td>No</td>
</tr>
<tr>
<td>XMT Files</td>
<td>WinTotal-specific format containing data, quantity and product details</td>
<td>XMT</td>
<td>Yes, using Import option</td>
<td>Yes, using XMT Import Server option</td>
</tr>
<tr>
<td>Windows Databases</td>
<td>Directly connecting to a database or spreadsheet via the Microsoft ODBC interface. Data and optional quantity details can be used.</td>
<td>Microsoft Excel SQL</td>
<td>Yes, using Import option</td>
<td>Yes, using Database Printing option</td>
</tr>
</tbody>
</table>

Table 4

4.5.1. ASCII Text Files

ASCII files are text files that can be imported into WinTotal.

They are often generated by other programs, but they can also be created manually using a text editor.

They are most commonly files with the extension TXT or CSV; both of these file formats can be generated from most office and production programs.

On scored and multi-column Product, a Field Separator must be defined to specify the location of data.

A Field Separator, also known as a Delimiter, is a character that is used in an ASCII file to specify a new data field.

The ideal format for an ASCII is that one line of data is equal to one sleeve or row of labels.
4.5.2. XMT Files

XMT files are text files that have a specific format unique to WinTotal. Not only the data to be imported in the file, but also the product, font, colour and quantities to print can be specified.

In addition, multiple products can be imported from one file into one set. One file can be created to make one set, with up to 100 different products in it.

The advantage of this format is that the user does not have to specify any parameters when importing, as they are defined in the file. Also, this file can be used with the XMT Import Server option to detect, import and print XMT files automatically.

The format and syntax of an XMT file is very specific and is described below:

XMT filename must have the extension .xmt. The filename of the xmt is the Set Name that will be used when importing, e.g. ABC123.xmt will Import into Set ABC123.

Line 1  This must contain “TMS90”

Line 2  Character 1 must contain a “9”. Characters 2-101 are optional for storing the Set Description field, if required.

Line 3  Character 1 must contain either an “8” or “4”: 8 for a Standard Product or 4 for a User Defined Layout.

Characters 2-21 should contain the description for the Product to be imported, as shown in the List Standard Products screen.

Character 22 should contain the colour code for the Product to be imported. See the XMT Colour Codes topic.

Character 23 should contain the font code for the Product to be imported. See the XMT Font Codes topic.

Character 25 should contain either an “S” or “D” to indicate whether the product is single sided or double sided.

Note: if a True Type code is used place the “S” or “D” immediately after this code; it will be at a higher character position than 25, but when using a True Type code this is OK.

If “D” option is selected the “0” can be used to specify the rear-side data instead of using a “6”, as in Line 5.

Characters 26 onwards are only for Continuous Products, used to specify their length.

This can be in mm or inches. M is used to identify mm and I is used to identify inches. Mm values are to one decimal place and inches values are to two. Example 3 shows all options for Continuous Products.

NB: If a True Type font code is used place the “S” or “D” immediately after this code – it will be at a higher character position than 25, but on a True Type font code this is OK.

Line 4  Character 1 must contain a “7” followed by a 4-digit quantity (valid range 0001-9999), indicating the number of times the following marker data are to be printed for each time the entire list is printed.
Line 5  Character 1 must contain a “6”. The Legend data for a single line or pre-scored section start at position 2.

The lines 4 through 5 are then repeated for the data.

If a new Product is required then a new Line 3-type of data can be inserted.

When the file is finished a “5” must be inserted as character 1 in the last line.

4.5.2.1. XMT Colour Codes

The colour codes shown below should be entered in position 22 of the Product record line of the XMT file. The pink colour code cannot be entered in the XMT file. To get the colour pink the Product should be changed using the Change Product option.

- 0 = Black
- 1 = Brown
- 2 = Red
- 3 = Orange
- 4 = Yellow
- 5 = Green
- 6 = Blue
- 7 = Violet
- 8 = Grey
- 9 = White
- A = Pink
- B = Silver
- I = Clear
- J = Amber
- K = Oyster
- L = Tan

4.5.2.2. XMT Font Codes

There are two different types of Font codes: Printer Embedded and True Type. For more information on which is best see the Font Selection topic.

- Printer-embedded Font Codes
- True-type Font Codes

4.5.3. Windows Database

Windows Databases is an option to connect directly to an external database file and import data from it.

The technology to do this is supplied in Microsoft Windows and is called ODBC (Open Database Connectivity). Any ODBC-compatible database data can be imported into WinTotal.

The only requirement for WinTotal is that the ODBC Database Driver is installed on the machine where WinTotal is installed and that the user has the access rights to read the database. Contact your system administrator if you have any questions regarding the installation of ODBC drivers.

There are two ways that WinTotal can access a Windows Database.
4.5.3.1. Import

This option will Import data from the selected database and save it in WinTotal. The connection to the database is required only at the time of Import. Any changes to the database will not be automatically sent to WinTotal. To get any updated data from the database the data must be deleted and re-imported into WinTotal. Once, imported, the data are available for users to print and edit in WinTotal, as required, without any changes being made in the source database. This option is available from the Windows Database tab in the Import screen.

4.5.3.2. Database Printing

This option will Import and Print the data from the database, but never save the data. The connection to the database is always required at Print time. Any changes to the database will be automatically sent to WinTotal. The user will only have the option to Print the data found in the database; editing is not allowed in WinTotal and no changes are made in the source database. This option is available from the Database Printing option.

For both Importing and Database Printing options a connection to the database must be made. In both screens there are options for New Connection and Edit Connection. These options will open the Database Connection Setup screen. Follow these screens and their options to configure the database connection.

4.5.3.3. Troubleshooting

If connection to an ODBC Windows Database gives incorrect results, please check that:

- The database you are connecting to is not opened by another program
- You have the correct ODBC drivers installed

Note: In Microsoft Excel there are two ways to specify which data are available in WinTotal:

- Named area – this is where the user can specify which area of the spreadsheet to use. To do this complete the following sequence:
  - select the area required
  - select the Insert Menu
  - select Name
  - select Define
  - type in a Name and save and quit the file. This Name is then used in the Select Tables screen of the Import wizard.

- The other option is not to create a Named area – in this case WinTotal will find the data based on the data that can be found in the sheet.

4.5.4. Database Connection Setup

The New Connection and Edit Connection buttons in both the Windows Database tab of the Import screen and the Database Printing screen will open the Setup screens.

These screens are shown in the following order:

- Select Data Source – only shown when a New Connection is made
- Select Tables
- Select Columns
- Select Filter – only shown if the Enable Filter Screen option is selected in the Select Columns screen
- Preview of Selected Tables and Columns
- Save Data Connection Name
4.5.4.1. Select Data Source

The screen in Figure 8 is used to specify the data source, from which the data are retrieved.

![Select Data Source](image)

**Figure 10**

This source must be specified in the Data Sources (ODBC) configuration screen found in the Administrative Tools section in the Microsoft Windows Control Panel. This can be accessed from the ODBC button.

Once the source is selected click Connect.

Depending on the source, a file may be required to be selected. If prompted select the file.

The **Select Tables** screen is then shown.
4.5.4.2. Select Tables

The screen in Figure 9 is used to select the table, from which the data are retrieved.

![Select Table Screen]

Figure 11

Select the required table(s) using the following options and click Next to continue to the Select Columns screen.

- >>> - moves the selected table(s) to the right target window
- <<< - moves the selected table(s) to the left source window
- Select all – selects all tables in the selected window
- Unselect all – unselects all tables in the selected window.

Selecting Back will return to the Select Data Source screen.
4.5.4.3. Select Columns

The screen in Figure 10 is used to select the columns, from which the data are retrieved.

![Figure 12](image)

Select the required table(s) using the following options and click Next to continue to the Preview of Selected Tables and Columns screen.

- moves the selected columns to the right target window
- moves the selected columns to the left source window
Select all – selects all columns in the selected window
Unselect all – unselects all columns in the selected window.

If required a filter can be applied to allow only certain data to be imported. This screen is accessed by selecting the Enable Filter Screen option. If enabled, the Next button will open the Select Filter screen.

If the database contains Unicode data, select the Unicode option.

Selecting Back will return you to the Select Tables screen.
4.5.4.4. Select Filter

The screen in Figure 11 is used to apply a filter to the selected data. Only data conforming to the filter will be imported.

![Figure 13](image)

Once the filter options have been specified click Next to continue to the Preview of Selected Tables and Columns screen.

Selecting Back will return you to the Select Columns screen.

4.5.4.5. Preview of Selected Tables and Columns

The screen in Figure 12 is used to preview the retrieved data.

![Figure 14](image)
The data can be previewed, if required. The First, Previous, Next and Last buttons can be used to view all the data to be imported.

Click Next to continue to the Save Data Connection Name screen.

Selecting Back will return you to the Select Columns screen, or the Select Filter screen if the Enable Filter Screen option is used.

4.5.4.6. Save Data and Connection Name

The screen shown in Figure 13 is used to save the Connection Name

![Figure 15](image)

Enter the Connection Name required and click Finish to save.

This name is then available for selection in the Database Connection list box in both the Windows Database tab of the Import screen and the Database Printing screen.

All connections made will show in the Connections List.
4.6. Font Selection

When a Product is created a Font can be selected. The ones available are dependent upon the Printer and Product type selected.

The types available are dependent on the selected Printer.

The font groups below describe these along with their advantage and disadvantages.

- Printer Fonts – these are stored in the Printer.
- Windows Fonts – these are stored in the Microsoft Windows system

4.6.1. Font Recommendations

<table>
<thead>
<tr>
<th>Model</th>
<th>Recommended Font</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAB A4+300</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>Epson LQ</td>
<td>Printer Font</td>
</tr>
<tr>
<td>ITS BTT-02 Card</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>LMS9000</td>
<td>Printer Font</td>
</tr>
<tr>
<td>T200 Ident</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T200 Label</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T2000CT</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T208M</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T208M-NEW</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T212M</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T212M-NEW</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T308S</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T312M</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T312S</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T312Z</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T408M</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T412S</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T424S</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T6112DS</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>T612M DS</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>TE3112</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>TE3124</td>
<td>Arial &amp; Courier New</td>
</tr>
<tr>
<td>Wheel 10 and above</td>
<td>Printer Font</td>
</tr>
<tr>
<td>Wheel 3,5 and 6</td>
<td>Printer Font</td>
</tr>
<tr>
<td>Wheelprinter E</td>
<td>Printer Font</td>
</tr>
<tr>
<td>Zebra 170xi</td>
<td>Arial &amp; Courier New</td>
</tr>
</tbody>
</table>

Table 5
4.6.2. Printer Fonts

A Printer Font is stored directly in the printer memory and was used traditionally to improve the printing speed.

With modern PCs now having large amounts of memory this reason is no longer applicable.

Windows fonts often have a better visual appeal when compared to a Printer Font, except on Dot Matrix models where a Printer Font is recommended for a crisper print.

4.6.2.1. Printer Fonts Available

<table>
<thead>
<tr>
<th>Printer Font Available</th>
<th>Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Epson LQ</td>
<td>Yes</td>
</tr>
<tr>
<td>T1008M</td>
<td>Yes</td>
</tr>
<tr>
<td>T1008M-NEW</td>
<td>Yes</td>
</tr>
<tr>
<td>T1228M</td>
<td>Yes</td>
</tr>
<tr>
<td>T1228M-NEW</td>
<td>Yes</td>
</tr>
<tr>
<td>T1008S</td>
<td>Yes</td>
</tr>
<tr>
<td>T1228M</td>
<td>Yes</td>
</tr>
<tr>
<td>T3332Z</td>
<td>Yes</td>
</tr>
<tr>
<td>T4098M</td>
<td>Yes</td>
</tr>
<tr>
<td>T4122S</td>
<td>Yes</td>
</tr>
<tr>
<td>T4124S</td>
<td>Yes</td>
</tr>
<tr>
<td>T41130S</td>
<td>No</td>
</tr>
<tr>
<td>T4124H BS</td>
<td>No</td>
</tr>
<tr>
<td>T5512</td>
<td>No</td>
</tr>
<tr>
<td>T55124</td>
<td>No</td>
</tr>
<tr>
<td>Wheeler 10 and above</td>
<td>Yes</td>
</tr>
<tr>
<td>Wheeler 3.5 and 6</td>
<td>Yes</td>
</tr>
<tr>
<td>Wheelprinter II</td>
<td>Yes</td>
</tr>
<tr>
<td>Xero 3R</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 6
4.6.3. Windows Fonts

A Windows Font is stored on the computer that is running WinTotal and sends this to the Printer at Print time as an image.

As default Arial and Courier New are available for selection in all Printers except Wheel 10 and above, Wheel 3, 5 and 6 and Wheelprinter E.

They are not recommended to be used on the Epson LQ model, but they are available if required.

The decision to use either Arial or Courier New is dependent upon a number of issues.

Additional Fonts can be used in WinTotal if required. Please contact your TE Connectivity representative for more information.

4.6.3.1. Arial

Arial is a commonly used font in the Microsoft Windows environment. It is a clear font to read and offers good readability.

The one disadvantage in WinTotal with Arial is that it is a proportional font, i.e. different letters can take up different widths. For example, a W and an I are dimensionally different. This means that the feature in WinTotal, which calculates the maximum characters per line, is not 100% accurate as it is character-dependent.

Arial Sample

THIS IS A SAMPLE OF THE ARIAL FONT
this is a sample of the arial font

4.6.3.2. Courier New

Courier New is a Proportional Serif font. It is not as easy to read as Arial, but still is a useful font.

A Serif font has “hats” and “tails” on all its characters.

It is slightly smaller in height when compared to the same point size in Arial.

The one advantage in WinTotal with Courier New is that is a non-proportional font, i.e. letters are always the same width.

For example, a W and an I are dimensionally the same.

Courier New Sample

THIS IS A SAMPLE OF THE COURIER NEW FONT
this is a sample of the courier new font
4.7. Serialisation

Serialisations are either numbers or letters that can be incremented.

There are two different methods of Serialisations.

4.7.1. Fixed Serialisation

This is where the values for the Serialisations are fixed and do not change at Print time. The Serialisations are always the same if printed multiple times. To change these Serialisations the user must edit their values. Here multiple Serialisations can be created within a Product.

4.7.2. Auto-numbering Product

This is specified in the Add Product screen and, when enabled, allows a single Legend to be added to a Product. This single Legend can then contain multiple Serialisations, which at Print time will increment and then remember the last printed value. When this Product is selected the next time, it will continue with the increment at the next value.

Regardless of the method used, the configuration for Serialisations is the same.

4.7.3. Numerical

Incremented numbers are created when the dollar sign ($) is specified. The number of dollar signs (maximum of seven) indicates the number of digits in the largest number to be printed.

Examples:

Serialisations from 1 to 9 should enter $
Serialisations from 1 to 99 should enter $$
Serialisations from 1 to 999 should enter $$$
Serialisations from 1 to 9999 should enter $$$$
Serialisations from 1 to 99999 should enter $$$$$$
Serialisations from 1 to 999999 should enter $$$$$$$$
Serialisations from 1 to 9999999 should enter $$$$$$$$$$

The output of a Serialisation can be adjusted by using the Leading Zero’s option at print time.

4.7.4. Alpha

Incremented upper and lower case letters can be indicated with a single “at” (@) sign.

The characters used for Numerical and Alpha sequences can be changed in the Options tab of the System Setup screen under the Serialisation Characters section. These should not be changed unless the user needs to Print either the $ or @ character. Whichever characters are used for Serialisation Characters cannot be printed.

When a $ or @ sign is entered into the data, the program will display a prompt to enter the parameters.

4.7.4.1. Base

This contains the first number or letter, with which the Serialisation will begin.

4.7.4.2. Increment
This is the incremental value that will be added to each number or letter to give the next Serialisations value. These can be positive or negative values.

4.7.4.3. Qty - Quantity

This will give the number of increments to Print.

Click with the LEFT button in the Legend # column to edit sequential information on the selected marker.

Note: This option is not available when using the Auto Numbering Product, as the Quantity to print is defined in the Print screen.

4.7.4.4. Group

This will divide the number of Qty by this Group figure to make duplicate copies of Serialisations. This option is available only if the Group tick box is selected in the Keypad. See the Add Data topic for more information on the Keypad.

To see the values entered for a sequential Legend, first select the Legend, then use the View Serialisations function.

4.8. Data Entry Order

Products in WinTotal can be scored and have multiple Lines on them.

There can be two different orders for adding data, both manually or imported.

The standard input method is as below:

![Diagram of data entry order]

Using the option Edit Order: Down-Across in the Options tab of the System Setup screen, this order can be changed to the following:

![Diagram of edited data entry order]

The Edit Order: Down-Across option is only effective for the data entry order. If the order needs to be changed for the Import option, then option Import Order: Down-Across in the Import screen can be used to give the same results.

4.9. System Administration

The following topics are useful for System Administrators.

- Data Management/Backup
- User Access Control

4.9.1. Data Management/Backup

This topic covers the file system that WinTotal uses and which files should be backed up.
4.9.1.1. User Access Rights

For WinTotal to function correctly the user must have full read/write access to the directory where WinTotal is installed and all its sub directories. The directories where data are to be saved must also have full read/write access. These rights are always required regardless of the User Access values in WinTotal.

4.9.1.2. Data Files (Sets)

When users create new Sets and Products in WinTotal these data are automatically saved. The Set Name that is used in WinTotal will be the file name that the data are stored in. There are two file formats that can be used for Sets.

4.9.1.3. WDF File Format

The default format for WinTotal v5 and newer versions saves the data to a single data file. The filename created will be the name used in the New Set screen followed by the file extension of .wdf.

4.9.1.4. SET File Format

Earlier versions of WinTotal used a different format. Those versions saved the data into multiple files with the following extensions (older format): .SET, .IND, .001, .002 and .00n (where n is the number of Products in the Set).

WinTotal v5 and newer versions have the option to save data in the older format, if required, for backward compatibility.

This can be done in two ways:

- Automatically for all data by using the Save Using WinTotal v98-v4.x format (.set) in the Options tab of the System Setup screen.
- Manually for any Selected Set by using the Save Using WinTotal v98-44.x format (.set) option in the SaveAs option under the File.

The user has the option to store these files in any Directory, both locally and on a Network. These files should be backed up periodically.

4.9.1.5. Custom Products

WinTotal has the functionality for users to create their own Products. This is done via the Design New Products screen. The files created for these Products are “custom.dat” and “custom.wtt”. These files are located in the following locations:

- Windows 2000, XP and 2003 Server, the files are located in the Products Directory section of the WinTotal program.
- Windows Vista and Windows 7 & 8; the files are in a Products Directory of the ProgramData Directory. The exact location is displayed as the WinTotal Data Directory in the About Software screen.

These files should also be backed up. However, they can only be restored on the same PC on which they were created. If you wish to transfer these files to another PC please contact TE Connectivity.
These files should be backed up periodically.

4.9.1.6. User-defined Layout

WinTotal has the functionality for the user to create a user template. This is done via the User-defined Layouts screen.

The file created for these Products is called “UserPrd.wup” and is located in the following locations:

- Windows 2000, XP and 2003 Server, the “UserPrd.wup” file is located in the Product Directory section of the WinTotal program.
- Windows Vista and Windows 7 & 8, the “UserPrd.wup” file is located in a Products Directory of the ProgramData Directory. The exact location is displayed as the WinTotal Data Directory in the About Software screen.

This file, unlike the Custom Products, can be transferred to different PCs using the Import and Export functions in the User-defined Layouts screen.

These files should be backed up periodically.

4.9.1.7. Configuration Files

All WinTotal configuration values are stored in the following files:

- WinTotal.ini
- label.ini
- wtlab32.cfg

These files are located in the following locations:

- Windows 2000, XP and 2003 Server: the files are located in the Directory of the location of the WinTotal program.
- Windows Vista and Windows 7 & 8: in the ProgramData Directory; this is displayed as the WinTotal Data Directory in the About Software screen.

These files should also be backed up, but should be restored only to the same PC or another PC if its configuration is identical.

4.9.1.8. Windows Database Connection

Any Windows Database Connections made are stored in a file called “odbcif.ini”.

This file is located in the following locations:

- Windows 2000, XP and 2003 Server; the files are located in the Directory called DbSetup in the location of the WinTotal program.
- Windows Vista and Windows 7 & 8: the files are in C:\ProgramData\WinTotal\DbSetup

These files should also be backed up, but should be restored only to the same PC or another PC if its configuration is identical.

4.9.2. User Access Control

This topic covers the user access option.
As default there are no user access limitations. If required there are three levels of access control.

These are configured in the User Access tab of the System Setup screen.

The access levels are defined by the following groups:

- Minimum Level – this allows a user to open Sets and Print them. Users cannot add/edit or Import any data.
- Medium Level – this allows the user the Minimum Level options plus the options to add/edit and Import data. Users cannot Design New Products or create User-defined Layouts.
- Maximum Level – this allows full access.

In the User Access tab of the System Setup screen the option Customise Minimum and Medium Level can allow the two lower access levels to be configured based on customer requirements.

Note: For WinTotal to function correctly the user must have full read/write access to the Directory where WinTotal is installed and all its sub directories. The directories where data are to be saved must also have full read/write access. These rights are always required regardless of the User Access values in WinTotal.

5. PROGRAM OVERVIEW

This section covers the functionality of commands in WinTotal.

These commands are available from multiple locations. They are sorted by the Menus on the main screen from which they are accessed.

![WinTotal Window]

These are:

- File
- Product
- Data Entry
- Print
- Preferences
- Help

5.1. File

This file contains the following options:
5.1.1. New Set

This option will open the New Set screen.

Accessed from:

- **File…..New Set Menu**

- **New Set** button on the **Toolbar**

- **New Set** button on the right-hand side of the screen.

5.1.1.1. Screen Options

- **Set Name**: This is the name used to store all data within a single Set. To change to location of new Sets, select the **Browse** option. For more information about Sets, see the **Selected Set** and **Data Management/Back-up** topics.

- **Set Description**: This optional field is for adding more information about the Set. Up to 100 characters can be used. This value can be searched for when using the **Show Set Description** option in the **Open Set** screen. This value can be changed later by the **Change Set Description** option in the **File**.

5.1.2. Open Set

This option will open the Open screen.

Accessed from:
• **File…..Open Set Menu**

• **Open Set button on the Toolbar.**

• **Open Set button on the right-hand side of the screen.**

Sets using both WDF and SET extensions will be displayed. For more information about file types see the *Data Management/Back-up* topic.4

5.1.2.1. Screen Options

• Show Set Description: This will display Sets by their Set Description. See the *New Set* and *Change Set Description* topics for more information.

5.1.3. Save As

This option will open the *Save As* screen.

Accessed from:

• **File……Save As menu**

• **Save As button on the Toolbar.**

This screen is divided in two sections: Current Set and New Set.

5.1.3.1. Screen Options

• **Current Set**

Convert to WinTotal v98.v4.x Format (.Set)

This option will only be visible when the selected Set is in the WDF format and the Save Using WinTotal v98-v4.x Format (.set) option in the *Options* tab of the *System Setup* screen is not enabled. When selected, the Current Set will be saved in the SET format.

Convert to v5 Single File Format (.wad)

This option will only be visible when the selected Set is in the WDF format and the Save Using WinTotal v98-v4.x Format (.set) option in the *Options* tab of the *System Setup* screen is not enabled. When selected, the Current Set will be saved in the WDF format.

• **New Set**

The New Set section allows the Current Set to be saved as a New Set.

Save using WinTotal v98-v4.x Format (.set)

---

4 This function is only required to select Sets outside of the current Data Directory. Those in the current Data Directory are available in the Selected Set list box in the main screen.
This option will only be visible when the Save Using WinTotal v98-v4.x Format (.set) option in the Options tab of the System Setup screen is not enabled. When selected, the Current Set can be saved with a new Set Name and Set Description in the SET format. If not selected, the Set will be in the WDF format.

5.1.4. Change Set Description

This option will open the Change Set Description screen.

Accessed from:
File.....Change Set Description menu.

This option allows the user to change the Set Description.

5.1.5. Delete Set

This will delete the Selected Set, including all data for all Products entered.

Accessed from:
File.....Delete Set menu.

5.1.6. Import

This option will open the Import screen.

Accessed from:
• File......Import menu
• Import button on the Toolbar

The screen has three tabs used to Import different file formats:

• ASCII Text
• XMT
• Windows Database

For more information on the file formats, see the Getting Data from External Sources section.

5.1.6.1. ASCII Text

The ASCII tab of the Import screen will allow ASCII text files to be imported.

5.1.6.1.1. Screen Options

Import File Section

This section is used to configure the Import File and options applied to the file when importing.

Files in the currently selected directory will be available for selection in the drop-down box. The selected file is the file to be imported.
Browse

This is used to select the directory and file to import. The default directory to be used can be specified using the Import Files Directory option in the Directories tab of the System Setup screen.

View File

This will display the content of the selected Import File. This will let users only see the contents of the file, not edit it. Use notepad or a similar text editor to change the input file.

Delete File

This will delete the selected Import File. Use caution because there is no recycle bin or un-delete command.

The Options button will show and hide the Import File Options.

5.1.6.1.2. ANSI Formats

This allows ANSI files to be used.

5.1.6.1.3. Skip First Line

This option does not Import the first line of the file. This is useful if the file contains header information to be omitted at Print time.

5.1.6.1.4. Import Order: Down-Across

Scored markers are read by default from left to right one line at a time, or one score at a time from top to bottom. This option changes this to left top to bottom, then right top to bottom. See the Data Entry Order topic for more information.

5.1.6.1.5. One Field per Line

A legend with more than one field (multiple lines or scores) can be separated on different lines using this option. It may be necessary also to use the Field Separator, depending on the file type.

5.1.6.1.6. Ignore Line Breaks

This option ignores all delimiters and line breaks, and imports the file as a single list.

5.1.6.1.7. Field Separator

This allows selection of standard Field Separators, which identify different fields in the Import File. Comma, Tab and Semicolon are available for selection. There is also an option to select a custom field separator by selecting User Defined and typing in the required separator.

5.1.6.1.8. Quantity Field No.

This option specifies which field in the input file is used for specifying the number for the Qty field in the Add Data screen.
5.1.6.1.9. Physical Lines per Logical

This allows the user to create a Product with, for example, three lines, but only Import data on the first two, leaving the last line empty for editing.

5.1.6.1.10. Output Set Section

This section is used to configure the Output Set.

- ![New Set](image)
  
  This button will open the New Set screen.

- ![Product Add](image)
  
  This button will open the Add Product screen.

- ![Change Product](image)
  
  This button will open the Change Product screen if a product is selected.

- ![Delete Product](image)
  
  This button will delete the selected product.

The Options button ![Options](image) will show and hide the Output Set Options.

5.1.6.1.11. Append Data

This option is available only if a marker is selected in a Set prior to importing into it. See Mouse Operation on how to select a marker. If selected, then the new data will be added to the existing data at the end of the current data.

5.1.6.1.12. Insert Data

This option is available only if a marker is selected in a Set prior to importing into it. See Mouse Operation on how to select a marker. If selected, then the new data will be inserted into the existing data at the end of the current data.

5.1.6.1.13. Preview before Import

This option will show the Preview screen before the import is started to allow the configuration to be checked.

5.1.6.1.14. Open Set after Import

This option automatically opens the Output Set after the import is completed. This option is not available if the Cancel to Exit Import Screen option is enabled in the Options tab of the System Setup screen.
5.1.6.1.15. Import to Default Data Directory

This option changes the directory to import to; from the current directory to the directory in the Data Directory option in the Directories tab of the System Setup screen. The destination directory is shown in the Directory field.

5.1.6.1.16. Preview

When enabled this option will open the Preview screen. This is useful to check the settings used and the data file prior to importing it.

5.1.6.1.17. Import

This will import the Import File to the Output Set.

5.1.6.1.18. Save

This option will save the settings used in the currently selected tab.

5.1.6.2. XMT

The XMT tab of the Import screen will allow XMT Files to be imported.

This section is used to configure the XMT Import File and options applied to the XMT file when importing.

Files in the currently selected directory will be available for selection in the drop-down box.

5.1.6.2.1. Screen Options

Import File Section

This section is used to configure the Import File and options applied to the file when importing.

Files in the currently selected directory will be available for selection in the drop-down box. The selected file is the file to be imported.

[Image: Browse]

This is used to select the directory and file to import. The default directory to be used can be specified using the Import Files Directory option in the Directories tab of the System Setup screen.

[Image: View File]

This will display the content of the selected Import File. This will let users see only the contents of the file, not edit it. Use Notepad or a similar text editor to change the input file.

---

5 XMT files are fully specified input files. They contain Set Name, Set Description, Product, Font, Data and Quantity. This allows the user to Import the correct data without mistakes.
Delete File
This will delete the selected Import File. Use caution because there is no recycle bin or un-delete command.

The Options button ▼ will show and hide the Import File Options.

5.1.6.2.2. ANSI Format

This allows ANSI files to be used.

5.1.6.2.3. Import Order: Down-Across

Scored markers are read by default from left to right one line at a time, or one score at a time from top to bottom. This option changes this to left top to bottom, then right top to bottom. See the Data Entry Order topic for more information.

5.1.6.2.4. Horizontal Align

This option allows the text to be horizontally aligned to Left, Centre or Right.

5.1.6.2.5. Vertical Align

This option allows the text to be vertically aligned to Top, Centre or Bottom.

5.1.6.2.6. Value of font in XMT file given is physical CPI

This makes the font code value the CIP value.

5.1.6.2.7. Use this font

This option overrides the XMT file-specified font with a chosen font. When enabled this will show the Bold and 6 and 9 Underlined.

5.1.6.2.8. Bold

Arial and Courier New Fonts are available with this option, which gives a darker mark when printed. This is recommended for most application.

5.1.6.2.9. 6 and 9 Underlined

Arial and Courier New fonts are available as this option. This will underline the numbers 6 and 9. This allows the correct orientation of the character to be determined, i.e. 6 and 9.

5.1.6.2.10. Import into Product

This allows the user to select another Product to the one in the XMT file. When enabled this will show the User Defined Layout option.

5.1.6.2.11. User Defined Layout

This allows the user to select a Product from the User-defined Layouts.
5.1.6.2.12. Output Set Section

The section is used to configure the Output Set.

The Set Name is automatically created from the name of the XMT file.

The Browse button allows the Output Set Directory to be changed.

The Options button \(\text{}\) will show and hide the Import File Options.

Append Data
This option is only available if a marker is selected in a Set prior to importing into it. See \textit{Mouse Operation} on how to select a marker. If selected, the new data will be added to the existing data at the end of the current data.

Insert Data
This option is available only if a marker is selected in a Set prior to importing into it. See \textit{Mouse Operation} on how to select a marker. If selected, the new data will be inserted to the existing data before the selected marker data.

5.1.6.2.13. Open Set After Import\(^6\)

This option automatically opens the Output Set after the import is completed.

5.1.6.2.14. Import to Default Data Directory

This option changes the directory to import to and from the current directory to the directory in the Data Directory option in the \textit{Directories} tab of the \textit{System Setup} screen. The destination directory is shown in the Directory Field.

5.1.6.2.15. Import

This will import the Import File to the Output Set.

5.1.6.2.16. Save

This option will save the settings used in the currently selected tab.

5.1.6.3. Windows Database

The \textit{Windows Database} tab of the \textit{Import} screen will allow Windows Databases to be imported.

5.1.6.3.1. Screen Options

Import File Section
This section is used to configure the Import File Database Connection.

\(^6\) This option is not available if the Cancel to Exit Import Screen option is enabled Options tab of the System Set-up screen
Windows Database connections are available for use in the Database Connection list box. The selected Database Connection is the connection used to import.

- **New Connection**
  This button can be used to open the Database Connection Setup wizard to create a new connection.

- **Edit Connection**
  This button can be used to open the Database Connection Setup wizard to edit the currently selected database connection.

- **Delete Connection**
  This button will remove the selected Database Connection. Use caution because there is no recycle bin or un-delete command.

The Options button will show and hide the Import File Options.

### 5.1.6.3.2. ANSI Format

This allows ANSI files to be used.

### 5.1.6.3.3. Import Order: Down-Across

Scored markers are read by default from left to right, one line at a time, or one score at a time from top to bottom. This option changes this to left top to bottom, then right top to bottom. See the Data Entry Order topic for more information.

### 5.1.6.3.4. Format Number Field

This option allows numeric fields to be converted to a specified number of decimal places by enabling the No. of Decimals option.

### 5.1.6.3.5. No. of Decimals

This option specifies the number of decimal places to be used when Format Numeric Field is enabled.

### 5.1.6.3.6. Show Database Fields

This option displays the available fields in a list box. This is a reference field to be used only to see which fields are in the Database Connection.

### 5.1.6.3.7. Quantity Field No.

This option specifies which field in the input file is used for specifying the number for the Qty field in the Add Data screen.

### 5.1.6.3.8. Records per Marker

This option allows the number of records in the database that equal one marker in WinTotal to be specified.
5.1.6.3.9. Output Set Section

The section is used to configure the Output Set.

- **New Set**
  This button will open the *New Set* screen.

- **Add Product**
  This button will open the *Add Product* screen.

- **Change Product**
  This button will open the Change Product screen if a product is selected.

- **Delete Product**
  This button will delete the *Selected Product*.

The Options button will show and hide the Output Set options.

5.1.6.3.10. Append Data

This option is available only if a marker is selected in a Set prior to importing into it. See Mouse Operation on how to select a marker.

If selected, the new data will be added to the existing data at the end of the current data.

5.1.6.3.11. Insert Data

This option is only available if a marker is selected in a Set prior to importing into it. See Mouse Operation on how to select a marker.

If selected, the new import data will be inserted to the existing product data before the selected marker data.

5.1.6.3.12. Preview Before Import

This option will show the *Preview* Screen before the import is started to allow the configuration to be checked.

5.1.6.3.13. Open Set After Import

This option automatically open the Output Set after the import is completed.

This option is not available if the *Cancel To Exit Import Screen* option is enabled in the *Options* tab of the *System Setup* screen.

5.1.6.3.14. Import to Default Data Directory

This option changes the directory to import to; from the current directory in the *Data Directory* option in the *Directories* tab of the *System Setup* screen.

The destination directory is shown in the Directory field.
5.1.6.3.15. Preview

When enabled this option will open the Preview screen. This is useful to check the settings used and the data file prior to actually importing it.

5.1.6.3.16. Import

This will import the Import File to the Output Set.

5.1.6.3.17. Save

This option will save the settings used in the currently selected tab.

5.1.7. Database Printing

This option will open the database Printing screen.

Accessed from:

- File…..Database Printing menu.
- Database Printing button 📊 on the Toolbar.

This screen is used to print data from a Windows Database without importing the data. To import data the Import option should be used.

For more information on Windows Database file formats see the Getting Data From External Sources section.

5.1.7.1. Screen Options

Job Section

Database Printing creates Job files that are used to store a Database Connection with a Product. This file is saved and can be selected and printed, without the data being imported and saved. These files are saved in the location specified in the Database Printing Directory option in the System setup screen.

Add

This will open the Name screen, for this Job files Name.

Rename

This will open the Name screen, allowing a selected Job to be renamed.

Delete

This will delete a selected Job file. Use caution because there is no recycle bin or un-delete command.
5.1.7.2. Product Section

The Add Product button will open the Add Product screen, allowing the product to be changed if required.

Once selected the button changes to a Change Product button, allowing the Product to be changed if required.

The Product information is then displayed. The information available is the same as displayed in the Select Product list box in the main screen and can be configured via the View tab in the System Setup screen.

5.1.7.3. Database Section

This section is used to configure the Database.

Windows Database connections are available for use in the Database Connection list box. The selected Database Connection is the connection used to print.

- New Connection
  This button can be used to open the Database Connection Setup wizard to create a new connection.

- Edit Connection
  This button can be used to open the Database Connection Setup wizard to edit the currently selected database connection.

- Delete Connection
  This button will remove the selected Database Connection. Use caution because there is no recycle bin or un-delete command.

5.1.7.3.1. ANSI Format

This allows ANSI files to be used.

5.1.7.3.2. Import Order: Down-Across

Scored markers are read by default from left to right, one line at a time, or one score at a time from top to bottom. This option changes this to left top to bottom, then right top to bottom. See the Data Entry Order topic for more information.

5.1.7.3.3. Format Number Field

This option allows numeric fields to be converted to a specified number of decimal places by enabling the No. of Decimals option.

5.1.7.3.4. No. of Decimals

This option specifies the number of decimal places to be used when Format Numeric Field is enabled.

5.1.7.3.5. Show Database Fields
This option displays the available fields in a list box. This is a reference field to be used only to see which fields are in the Database Connection.

5.1.7.3.6. Quantity Field No.

This option specifies which field in the input file is used for specifying the number for the Qty field in the Add Data screen.

5.1.7.3.7. Records per Marker

This option allows the number of records in the database that equal one marker in WinTotal to be specified.

5.1.7.4. Preview

When enabled this option will open the Preview screen. This is useful to check the settings used and the data file prior to actually importing it.

5.1.7.5. Print

This will open the Print screen, allowing the Database Connection to be printed.

5.1.8. Data Conversion

There are various conversion program available in this section.

Accessed from:

- File….Data Conversion

The main program for general use is the WinTotal Internal conversion program.

5.1.8.1. WinTotal Internal

The WinTotal Data Conversion program allows global conversion of XMT Files, Total and WinTotal files.

5.1.8.2. Input File Types

This option opens up the Cross Reference List options for XMT and WinTotal conversions.

From

This specifies the source data. There are currently two options:

- XMT – for globally importing XMT files
- WinTotal/Total – for converting Total or WinTotal files

To

This option specifies the output file type. There are currently two options:

- XMT – for globally importing XMT files
- WinTotal – for WinTotal files

5.1.8.2.1. Import Unmatched Products

This option copies any source file not specified in the Cross Reference List as its original format.
5.1.8.2.2. Source Directory

This window specifies the source location for selecting files.

5.1.8.2.3. Existing Files

This window shows any files in the current Source Directory. It will only show files based upon the selection in the From section.

5.1.8.2.4. Destination Directory

This window shows the location where any converted Sets will be placed.

5.1.8.2.5. Destination Files

This window shows any files in the current Destination Directory. It will only show files based upon the selection in the To section.

5.1.8.2.6. Convert All Files

This option will convert all files in the Source Directory to the Destination Directory.

5.1.8.2.7. Convert Selected Files

This option will convert only selected files in the Source Directory to the Destination Directory.

5.1.8.3. Cross Reference List

The Cross Reference List is used to specify source and destination Products. There are cross reference lists for both XMT and Total/WinTotal conversions.

Once this screen appears a list of all source Products in the Source Directory will be available in the list box and can be refined by selecting the Refine Selection option.

5.1.8.3.1. Screen Options

Refine Selection

The Refine Selection screen allows parts of the selection process to be ignored in the selection for the Source Product.

These options will group the following and replace them with asterisks (*) in the Source Product list box.

- Ignore Text Alignment
- Ignore Font Description
- Ignore Colour
- Ignore Double Sided
- Ignore Lines
- Ignore Size
- Ignore Derivative

This allows simple creation of Product groups rather than specifying each individual Product.

Target Product for Selected Source
This opens the Define Product screen where the target Product for the Source Product is selected. The following screen is then displayed allowing the user to specify its target Product.

The screen has the same options as in the Add Product screen, but has the addition of a Printer field.

If the Printer requires changing this should be done first to show the correct Product options for that Printer.

The target Product can then be built up in the same way as creating a Product in the Add Product screen.

Any parameter that is required to stay the same should be selected with ****.

Greyed-out tick boxes will also leave those parameters as the Source Product.

Once specified the Source Product is removed from the list box and added to the Cross Reference Table along with its target Product.

This process should be repeated until all Products that require converting in the Source Directory are in the Cross Reference Table. Any Products not in the Cross Reference Table will not convert unless the Import Unmatched Products option is enabled. In this case the Products will be copied the same as the Source Product.

Show Details
This option shows more details in the Cross Reference Table.

Change
This option allows the user to change any selected Cross Reference Table item.

Delete
This option allows the user to delete any selected Cross Reference Table item.

Delete All
This option will delete all Cross Reference Table items.

5.1.8.4. Export

This option will open the Export screen, which allows data from an existing WinTotal Set to be exported to text files.

Accessed from:

- File…..Export menu

5.1.8.4.1. Screen Options

Output File Section

Output File
This as default will be in the same Name and Directory as the Selected Set. If required the Change File option can be used to select a different Output File and Directory.

5.1.8.4.2. Header Information on Line 1 Section

Header Information on Line 1
This allows the Header Information on Line 1 to be inserted into the Output File. To enable this option the Include option must be enabled. As default the Product, Lines and, if selected, the Double-sided values will be the Header Information on Line 1. This can be edited if required.
5.1.8.4.3. Output Format Section

Delimiter Separated Fields
This option will allow the file to be exported using a Delimiter to separate data for each Legend and its scores. Comma, Tab and Semicolon are available for selection. There is also an option to select a custom field separator by selecting User Defined and typing in the required character.

Fields on Separate Lines
This option will separate all Legend data and scores onto separate lines.

ANSI Format
This allows ANSI files to be used.

Remove Trailing Spaces
This will remove any spaces at the end of the data, if they exist.

5.1.8.4.4. Legends to Export Section

Total Number of Legends
This will display the total number of legends to be exported.

First Legend
This option can be used to specify the First Legend to be exported. This is 1 as default.

Last Legend
This option can be used to specify the Last Legend to be exported. This is the last one in the Selected Set as default, but it can be adjusted if required.

Front Side
This option is available only if a Double-sided Product is selected. Selecting this option will only export the Front Side data.

Back Side
This option is available only if a Double-sided Product is selected. Selecting this option will only export the Back Side data.

Both Sides
This option is available only if a Double-sided Product is selected. Selecting this option will export data from both sides.

Example
The product below is a marker with two scores (three fields across) and two lines. The following outputs would be achieved based upon their configuration values:

```
<table>
<thead>
<tr>
<th>AAAA</th>
<th>BBBB</th>
<th>CCCC</th>
<th>FFFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
</tbody>
</table>
```

Delimiter Separated Fields = Comma
AAAA, BBBB, CCCC, DDDD, EEEE, FFFF

Fields on Separate Lines
AAAA
BBBB
CCCC
DDDD
EEEE
FFFF
5.1.8.5. Log Off

This option is enabled only if User Access level passwords have been created for logging on to WinTotal. It allows the user to log off his current password level without having to Exit the program completely.

5.1.8.6. Exit

This option will Exit the program.

Accessed from:

File…. Exit menu

Exit button on the Toolbar

The “X” close option at the top of the right corner of the main screen

Selecting the END key on your keyboard

A Warning screen will be displayed asking for confirmation to Exit the program.

This warning can be turned off from Confirm Program Exit option in the Options tab of the System Setup Screen.

The END key will always display this Warning.

5.2. Product

This contains the following options:

- Add Product
- Change Product
- Delete Product
- List Standard Products
- User Defined Layouts
- Design New Products
- Advanced Label Fields
- Advanced Label Editing
5.2.1. Add Product

This option will open the AddProduct screen.

Accessed from:

- Product….Add Product menu
- Add Product button on the Toolbar
- Add Product button on the right-hand side of the screen

This screen is used to specify the Product to be used.

There are two different options available for selection: Standard Product and User Defined Layout.

5.2.1.1. Screen Options

Standard Options

The Standard Product allows previously created TE Connectivity templates and templates created by the Design New Products option to be selected. See the Printer/Product Compatibility List topic for compatible combinations.

5.2.1.1.1. Select Product

This allows the user to select the Line being used. There are two options:

- System 90 – older
- System 6/HIS - current

Family

This list box allows the user to select the Family, to which the Product belongs, normally the first part of the part number, e.g. Sleeve.

Type

This is the Product Type, e.g. SCE

5.2.1.1.2. Attributes

This is the Product size, e.g. 3/32

Derivative

This refers to either the length, number of pre-scores, or the format of the Product.

Font

The available fonts for the Product and Printer combination should be available. Printer-embedded fonts are listed first, followed by Arial and Courier New. See Font Selection for more information.

Bold

Arial and Courier New fonts are available with this option, which gives a darker mark when printed. This is recommended for most applications.

6 and 9 Underlined
Arial and Courier New fonts are available with this option. This will underline the number 6 and 9. This allows the correct orientation of the character to be determined, i.e. 6 and 9.

Lines
This option allows the user to select the number of lines of text required on the Product.

Colour
This allows the colour of the Product to be selected. Only available colours will be shown.

Double Sided
This allows the Product to have different text on both front side and rear side. This is not required if both sides have data that are the same.

Rotate Back Side 180
This option is enabled when selecting the T612M DS or T6112DS printer. This rotates the rear side of a double-sided Product by 180 degrees.

Rotation
This will allow the Rotation of the text to be selected. 0, 90, 180 and 270 options are available where the Product and Printer allow.

Horizontal Align
This option allows the text to be horizontally aligned to left, centre or right.

Vertical Align
This option allows the text to be vertically aligned to top, centre or bottom.

5.2.1.1.3. Dimensions

The Dimensions section of the Add Product screen is displayed when a Continuous Family Product is selected. It is also available for the Sleeve (System 2000) Product types when using the T2000CT printer.

See the Printer/Product Compatibility List topic for a compatibility list.

Length Type
This allows the Add Product length to be entered using one of the following measurements:

- Length mm
- Length inch
- Diameter mm – not available for Sleeve family
- Diameter inch – not available for Sleeve family

Length
This option allows the user to input a length or diameter figure based upon the Length Type selection.

Disable Occurs
This option disables the Occurs function for the Continuous Family.

Advanced
This option will open an Advanced Product Setting screen where the Overlap and Minimum Distance between Occurrences can be configured.

Overlap
This option is available for the System 90 Product and allows an Overlap area to be defined within the Length where data cannot be printed.

Minimum Distance Between Occurrences
This option can be used to customise the space between *Occur*.

### 5.2.1.4. Auto Numbering Products

This option will allow an Auto-numbering Product to be created. This is a Product that allows only one Legend to be created. When *Serialisations* are added they will be remembered when printed and will print the next Legend from the next value. For more information see the *Serialisations* section.

When Auto-numbering Product is selected, the following options will be visible:

#### Update Counters after Print

This will updated the counter to start from the next value when next printed. If not selected, the counter will reset to the original base value. For more information see the *Serialisations* section.

#### Prompt after Printing Product

This will prompt the user after printing to confirm if all Legends were printed correctly before updating the counters. If unselected, no prompt will be shown and the counter update will be applied automatically.

#### WYSIWYG

This option will enable the WYSIWYG display for the Product. This will result in a display showing the product to scale, together with its preview showing the colour, carrier, tractor feed holes etc.

If disabled a rectangular box will be displayed showing only the data. This option has no effect on its output to a Printer.

#### Max Characters per Field

This option shows the maximum number of characters allowed to be entered on to the Product. This is an accurate figure for Courier New and printer-embedded fonts. However, for Arial it is an approximate value. See *Font Selection* for more information.

#### Save as Default

This option saves the Product selection. These values will be used as default when the Add Product screen is next opened.

### 5.2.1.2. User Defined Layout

The User-defined Layout allows Products created from the User-defined Layouts screen to be selected.

#### Name

This is a list of all User-defined Layouts available.

#### Horizontal Align

This option allows the text to be horizontally aligned to left, centre or right.

#### Vertical Align

This option allows the text to be vertically aligned to top, centre or bottom.

### 5.2.1.2.1. Auto Numbering Products

This option will allow an Auto-numbering Product to be created. This is a Product that allows only one Legend to be created. When *Serialisations* are added they will be remembered when printed and will print the next Legend from the next value. For more information see the *Serialisations* section.

When Auto-numbering Product is selected, the following options will be visible:

#### Update Counters after Print

This will updated the counter to start from the next value when next printed. If not selected, the counter will reset to the original base value. For more information see the *Serialisations* section.
Prompt after Printing Product
This will prompt the user after printing to confirm if all Legends were printed correctly before updating the counters. If unselected, no prompt will be shown and the counter update will be applied automatically.

WYSIWYG
This option will enable the WYSIWYG display for the Product. This will result in a display showing the product to scale, together with its preview showing the colour, carrier, tractor feed holes etc.

If disabled a rectangular box will be displayed showing only the data. This option has no effect on its output to a Printer.

Save as Default
This option saves the Product selection. These values will be used as default when the Add Product screen is next opened.

5.2.2. Change Product
This option will open the Change Product screen.

Accessed from:
- Product….. Change Product menu
- Change Product button on the Toolbar

This screen is identical to the Add Product screen and allows the current Selected Product to be changed.

Caution should be used when changing Products. Data may be lost or truncated if the new Product has fewer or smaller Print fields.

5.2.3. Delete Product
This option will delete the current Selected Product within the Selected Set. All of the data for that Product will be deleted.

Accessed from:
- Product…..Delete Product menu

If no Product is selected when the Delete Product option is selected, a list of all those in the current Set will be displayed.

By ticking the box to the left, the selected ones will be deleted when the Delete button is pressed.
5.2.4. List Standard Product

This option will display the List Standard Product screen.

Accessed from:

- Product….List Standard Products menu

This screen displays all the Products available in WinTotal.

The Line (System 90 and System 6/HIS) are listed with the Family (sleeve, label, cable marker, card and continuous) and exact Product description.

The number of pre-scores is listed, together with Dimensions in millimetres. The number of line feeds from the top of one marker to the top of the next is listed for each Product.

A System 90 line feed is different to the System 6/HIS standard 6 lines-per-inch line feed. System 90 Product MUST be printed using the System 90 platen, with a special gear handle the non-standard marker spacing.

5.2.5. User Defined Layouts

This option will display the User-defined Layouts screen.

Accessed from:

- Product….User-defined Layout menu

A User-defined Layout is a Product that can be created by a user based on a Standard Product. A User-defined Layout is selected in the Add Product screen by the radio button at the top of the screen.

A User-defined Layout contains all parameters that can be selected in the Add Product screen and allows these parameters to be saved to a name of the user’s choice.

If required a label file can be attached to the User-defined Layout, allowing for custom formatting of the Layout.
5.2.6. Screen Options

New
This will open the Create New User-defined Layout screen. Here the User-defined Layout Name can be specified (up to 50 characters including spaces). A Standard Product must then be selected as the base for the User-defined Layout. See the Add Product section for more information. The Default Lines per Product option will only show the number of lines available as per standard products. Removing this option will allow up to 100 lines per product.

Change
This option allows the Product used to create the User-defined layout to be changed. Here a selected User-defined Layout can also be renamed.

Delete
This option allows the user to remove any selected User-defined Layouts. Multiple layouts can be selected using the standard Windows method, using CTRL or SHIFT keys with mouse selection.

Import
This allows existing User-defined Layouts to be imported from different installations of WinTotal and merged into the current installation.

Export
This allows existing User-defined Layouts to be exported from the current installation, either for back up or to be imported into another copy of WinTotal.

Layout Details
This shows the details of the User-defined Layout. The values that are displayed are the same in the Selected Product list box in the main screen and can be configured via the View tab in the System Setup screen.

Attach a label to the selected User-defined Layout
This adds a label template to the selected User-defined Layout. A template label allows a custom label design to be made using the features in Advanced Label Editing. Deselecting this option will remove the label from the selected User-defined Layout.

Label Editing
When a label is attached to a User-defined Layout, the Label Editing button will be available. This option allows the user to edit and attach label templates. Double click on any field to modify its font. Graphic and Barcode can be added to the label as fixed fields that will be printed on all markers. After making changes, press the Back to WinTotal button to return to the User-defined Layout screen.

5.2.6.1. User Defined Layout Options

Change Layout
This button allows a User-defined Layout to have defined areas that are unprintable. For example, the placement of scores in pre-cut markers can be created by clicking the mouse on an area you wish to make unprintable on the marker.

When clicking the Layout window, a symbol indicating an unprintable area is displayed. When the Layout is completed select Save.

5.2.7. Design New Products
This option will display the Design New Products screen.

Accessed from:

- Product….Design New Products menu

This screen allows a new Product to be added to WinTotal. It also displays a list of those already created.

5.2.7.1. Screen Options

New
This will open a screen asking the following:
- Create from new – this will open the Edit Product screen.
- Load values from a Standard Product – this will open the Select Standard Product screen.

Change
This allows a created Product to be changed.

Delete
This button will remove any highlighted Product. There will be no warning message prior to removing the Product design. To undo the Delete function, press the Cancel button on the Design New Products screen.

5.2.7.1.1. Select Standard Product

The Select Standard Product screen is used to select the product to be used as the starting point for the Design New Products function.

Products can be sorted and filtered to make selection easier.

5.2.8. Design New Products – Edit Product

The Edit Product screen is divided into three tabs.

- Dimensions
- Appearance
- Printers

5.2.8.1. Dimensions

The Dimensions tab allows users to create the basic layout of the Product.

Note: If the product is created using the Load values from a Standard Product option, some options on this screen will not be editable.

5.2.8.1.1. Screen Options

Product

Family
This list box specifies in which group of Products the new design will be included. The user can add the new Product as a Sleeve, Label, Cable Marker, Continuous or Card. This choice will determine where the Products are displayed during Add Product selection.
Note: If a Product is added to the Continuous Family, the height, printable area and vertical pitch are not allowed to be specified, as they are not required. Any Printer that uses this Product will also be configured to run in continuous mode, if it has one. Do not add to this Family any Products that require the printer sensor to function.

Type, Size and Derivative
The Product name is made up of the type, size and derivative fields, separated by a space. It can be up to 20 characters in length, consisting of any characters.

Dimensions

Width
The Width of an individual Product can range from 3mm to 500mm, or 0.12" to 19.6".

Height
The Height of an individual Product can range from 3mm to 500mm, or 0.12" to 19.6".

Printable Area
The Height and Printable Area are most often the same. During entry of the Height, the same value will be automatically placed in the Printable Area field. The values will be different if the actual Printable Area of the Product is less than the total Height. Product will a long, clear wrap-around end are examples of where the Printable Area is smaller than the Height.

Number Across
This value is based on the carrier format. This field is necessary for Products supplied on a wider carrier with more than one column across each row (both across and down from each other). The total number across a single row should be entered in this field.

Rows per Page
The Rows per Page on a single sheet needs to be entered in order to Print accurately. Products not separated on individual sheets should have a value of one in this field (if displayed).

Horizontal Pitch
This value is only necessary if the Number Across value is greater than one. For Products with multiple columns, the entry is the sum of the Width and the gap between each across (the measurement from the left edge of one column to the left edge of the next column immediately to its right). If there is no gap, the Horizontal Pitch will equal the Width.

Vertical Pitch
This value is the sum of the Height and gap between each row (the measurement from the top edge of one row to the top edge of the row immediately beneath it). If there is no gap, the Vertical Pitch will equal the Height.

Top Margin
This is the default Top Margin value that will be displayed in the Print screen. This can be overridden at Print time.

Left Margin
This is the default Left Margin value that will be displayed in the Print screen. This can be overridden at Print time.

Double Sided
This is used to allow the product to be created as a Double-sided one.

Show Information
This will show Information Symbols on the preview of the design to help understand the Dimensions required.

5.2.8.2. Appearance
The Appearance tab allows users to create the WYSIWYG view of the Product.

5.2.8.2.1. Screen Options

Colours
This is an option used for accurate visual display. It has no effect on printing. One or more colours can be specified.

Rotation
This will allow the Rotation of the text to be selected. 0, 90, 180 and 270 options are available where the Product and Printer allow.

WYSIWYG
This option will enable the WYSIWYG display for the Product. This will result in a display showing the product to scale, together with its preview showing the colour, carrier, tractor feed holes etc.

If disabled, a rectangular box will be displayed showing only the data. This option has no effect on its output to a Printer.

5.2.8.3. Printers

The Printers tab allows users to select the Printers capable of printing the created Product.

Note: If the product is created using the Load values from a Standard Product option, the options on this screen will not be editable.

As default the Default Printer will be added. This is the Printer configured in the Printers tab of the System Setup screen.

5.2.8.3.1. Screen Options

Add Printer(s)
This will open a screen where a list of available Printers will be displayed.

Remove Selected Printer
This will remove a selected Printer from the Allowed Printers list.

Remove ALL Printers
This will remove all Printers from the Allowed Printers list.

Cut
This will allow the product to be cut if a compatible Printer is selected.

Continuous Media
This should be selected when the Continuous Media option is used. This will configure the sensing mode for the Printer.

Printer Set Up
On some printers additional options can be configured.

5.2.9. Advanced Label Fields

This option will allow Advanced Label Fields to be added to a Product without accessing Advanced Label Editing.

Accessed from:
• Product….. Advance Label Fields menu

The menu then displays multiple options. For more information please read the help file in the Advanced Label Editing program.

5.2.9.1. Screen Options

Single-line Text
The option allows a new Single Line Text field to be added to the Product.

Multi-line Text
This option allows a new Multi-line Text field to be added to the Product.

Barcode
This option allows a new Barcode field to be added to the Product.

Barcodes supported are Codabar, Code 39, Code 93, EAN-13, EAN-8, UPC-A, UPC-E, Interleaved 2/5, Industrial 2/5, ITF (DIN14), Matrix 2/5, MSI, Code 128m, EAN128 and AI EAN 128.

Graphic
This option allows a new graphic field to be added to the Product. Company logos or graphics can be imported in BMP, PCX, MSP, WMF, JPG, JIF and GIF formats.

Rectangle
This option allows a new Rectangle field to be added to the Product.

Line
This option allows a new Line field to be added to the Product.

Circle
This option allows a new Circle field to be added to the Product.

5.2.10. Advanced Label Editing

This option will open the Advanced Label Editing screen.

Accessed from:

• Product….Advanced Label Editing menu

• Advanced Label Editing button on the Toolbar

This function allows advanced editing functions of the WinTotal template to be made.

Extreme care should be taken when modifying the WinTotal default properties. Only Advanced Users should use this function.

Refer to the on-line Help screens to assist with this function. Once any changes have been made the screen can be closed by either the Close icon or the Back to WinTotal option under the File menu. This will prompt for the changes to be saved or cancelled.

5.3. Data Entry

This contains the following options:
5.3.1. Add Data

This option will open the main screen in Add Data mode.

Accessed from:

- Data Entry….Add Data menu
- Add Data button on the Toolbar
- Add Data button on the right-hand side of the screen

Once the Add Data option has been selected, the data can be typed in.

5.3.1.1. Screen Options

Legend #
A Sleeve, Cable Marker, Label, Card or Continuous Product is called a Legend. These are automatically numbered, starting at 1.

Once the data in the first field/Legend is created, pressing the Enter key on the keyboard will advance to the Next Field or Legend.

The order in which the fields are entered as default is Across then Down. This can be changed. See the Data Entry Order topic for more information.

A Legend is saved when the next Legend is entered. To exit the Add Data mode, enter into a new empty Legend and press the ESC button on the keyboard or select the Exit Data Entry button.
5.3.1.2. Quantity - Qty

As default a Legend quantity (Qty) of 1 is added. This is the number of times an individual Legend will be printed each time the Product is printed. If different values for individual Legends are required, then this option is recommended.

If the Qty required is the same for all Legends, this value can be specified at Print time and does not need to be created for every Legend.

The value can be changed by enabling the Edit Quantity option on the Keypad. If enabled, the user is prompted to enter the Qty for each Legend.

To change the quantity of an existing Legend, select the Legend and click in the Qty area. The quantity field will become an entry box with the current quantity listed. Type the new quantity and then press the Enter button.

5.3.1.3. Occurs

This field appears when a Continuous Family Product is selected, unless the Disable Occurs option in the Add Product screen was selected.

This option allows a user to specify how many times the lines of data will be repeated on a single Legend at Print time. This allows data to be entered into WinTotal for one group of lines, then automatically repeated at Print time to fill the Legend.

5.3.1.4. Keypad

When in Add Data mode the Keypad becomes visible on the right-hand side of the screen.

Copy Previous Legend
This will copy the previous Legend data into the current Legend. This command can also be accessed by pressing F5 on a keyboard.

Copy 1st Score Across Line
This will copy the first-score data on the current line across the remaining scores on the current line. This command can also be accessed by pressing F6 on a keyboard.

Reverse Line Order
This will duplicate the previous Legend data into the current Legend, reversing the order of the lines. This command can also be accessed by pressing F3 on a keyboard.

Mirror Score
This option has two different functions depending on the Product.

- Scored Product will mirror the data between the different scores.
- For the non-scored product the forward slash ("/") can be used to indicate the separation of fields and the mirror point.

Mirror Previous Field
This option will duplicate the previous fields’ data, using the forward slash ("/") to indicate the separation of fields and the mirror point. This command can also be accessed by pressing F4 on a keyboard.

Copy Previous Legend Line
This option will duplicate the current line with the data from the same line from the previous Legend. This command can also be accessed by pressing F11 on a keyboard.

Copy 1st Line to All Lines
This option will duplicate the 1st line of the current Legend to all lines within that Legend. This command can also be accessed by pressing F12 on a keyboard.

Constants
The F7, F8, F9 and F10 keys can be used to insert specific user data. If data are configured for the buttons, these data will be shown on the button. Selecting the key or the corresponding F key will insert these data where the text prompt is currently placed. Constants are configured using the Constants option in the Data Entry.

Constants
This function is the same as the Constants menu.

Field Navigation
The options are:

Next Field – this button will advance the cursor to the Next Field. The Down Arrow or Enter buttons will also do this.

Previous Field – this button will return the cursor to the Previous Field. The Up Arrow button will also do this.

Edit Quantity
This option allows the user to be prompted to enter a Legend quantity. If disabled the user is not prompted and a default value of 1 is used.

Group
This field can be used for creating grouping within Serialisations.

5.3.2. Change Data
This option will open the main screen in Add Data mode, allowing the selected Legends to be edited.

This option is only available if a Legend or multiple Legends are selected (see Mouse Operation on how to select Legends).

Accessed from:

- Data Entry….Change Data menu
- Change Data button on the Toolbar
- Change Data button on the right-hand side of the screen

Editing can also be achieved by double clicking each Legend.

5.3.3. Insert
This option is only available if a single Legend is selected (see Mouse Operation on how to select Legends).

This allows a new Legend to be inserted before the selected Legend.

Accessed from:

- Data Entry….Insert menu
- Insert or Ins key on a keyboard
5.3.4. Delete

This option allows Legends to be deleted.

Accessed from:

- Data Entry….Delete menu
- Insert or Del key on a keyboard

If any Legends are selected (see Mouse Operation on how to select Legends) when a Delete command is used, the Delete screen is displayed with the default option – Delete Selected Legends – selected.

If no Legends are selected when a Delete command is used, the Delete screen is displayed with the default option – Delete Legend Range – selected.

The From Legend # and To Legend # options can then be used to specify which range to delete. The Maximum Legends = text will display the maximum values that are allowed.

5.3.5. Copy

This option allows Legends to be copied within the current Product.

Accessed from:

- Data Entry….Copy menu

The Copy screen allows the From Legend # and To Legend # options to be specified for the range to Copy.

The Insert Before Legend # is the insertion point for the copied data to be placed. If a Legend is selected (see Mouse Operation on how to select Legends) this Legend # is automatically added as the insertion point.

The Maximum Legends = text will display the maximum values that are allowed.

5.3.6. Find

This option allows data within Legends to be searched for.

Accessed from:

- Data Entry….Find menu
- CTRL + F on the keyboard

The Find screen displays the From Legend # and To Legend # options, which are used to specify within which range to search.

The Maximum Legends = text will display the maximum values that are allowed.

The Find What section is used to enter the data to search for.

The Match Case option returns only find data that match the upper and lower case characters in the Find What section.

When data are found the Find Results screen is shown, which displays the Legend # of the found data.
The Find Next button will search for the next Legend.

The New Search button will return to the Find screen.

If no data or no more data are found, a Warning screen is shown.

5.3.7. Replace

This option allows data within Legends to be searched for and replaced.

Accessed from:

- Data Entry….Replace menu

The Replace screen displays the From Legend # and To Legend # options and can then be used to specify within which range to search.

The Maximum Legends= text will display the maximum values that are allowed.

The Find What section is used to enter the data to search for.

The Replace With section is used to enter the replacement data.

The Match Case option makes the search find only data that match the upper and lower case characters in the Find What section.

The Replace button will begin the search.

When data are found the Replace Results screen is shown, where the Legend # is displayed for any found data.

The Replace button will replace the current Legend.

The Replace All button will replace all data matching the Find What and Replace With options.

When a replacement process is completed a screen is displayed showing the number of substitutions made.

5.3.8. Move

This option allows Legends to be moved within the current Product.

Accessed from:

- Data Entry….Move menu

The Move screen shows the From Legend # and To Legend # options, which can be used to specify which range to move.

The Maximum Legends = text will display the maximum values that are allowed.

5.3.9. View Serialisations

This option is available when a single Legend with Serialisations is selected.
Accessed from:

- Data Entry….View Serialisations menu

This *View Serialisations* screen will show the values for any *Serialisations* on the selected Legend.

The Show Back Side option is available to show the rear side data if a Double-sided Product is selected.

5.3.10. Constants

This option will open the Constants screen.

Accessed from:

- Data Entry….Constants menu

The F7, F8, F9 and F10 are keys that can be used to insert frequently used words or phrases of up to 77 characters long.

If data are configured for the buttons, these data will be shown on the Keypad in the *New Set* screen.

5.4. Print

This contains the following options:

- Print
- Manual Print
- Advanced Print
- Print Preview
- Paper Report
- Print Log

5.4.1. Print

This option will open the Print Legends screen.

Accessed from:

- Print….Print menu
- Print button on the *Toolbar* 
- Print button on the right-hand side of the screen
- CTRL + P on the keyboard
The printer being used is shown in the header of this screen.

All values used in this screen will be saved with the current Product in the current Set. They will be remembered for future used. To reset the values to default, the Change Product option in the Data Entry menu can be used.

The screen is divided into several sections.

5.4.1.1. Screen Options

5.4.1.1.1. Positioning

This section allows the positioning of the data to be adjusted at Print time. The following options are available:

Top Margin
This allows the position of all data on the Legends to be moved up and down.

Increasing this value will move the data down and decreasing it will move the data up.

Negative values can be used on some printers.

If the required adjustment has no effect then adjustments on the printer itself may be required. Contact TE Connectivity for information.

Left Margin
This allows the position of all data on the Legend to be moved left and right.

The default value will vary depending on the printer and Product combination. Increasing this value will move the data to the right and decreasing it will move the data to the left.

Negative values can be used on some printers.

If the required adjustment has no effect then adjustments on the printer itself may be required. Contact TE Connectivity for information.

Back-side Top Margin
Only available for the T612M-DS and T6112DS Printers. This allows the position of all data on the Legends to be moved up and down on the bottom head.

Increasing this value will move the data down and decreasing it will move the data up.

Negative values can be used on some printers.

If the required adjustment has no effect then adjustments on the printer itself may be required. Contact TE Connectivity for information.

Line Spacing
This option is available only when a Product with more than one Line is created. This allows the user to increase or decrease the vertical space between the Lines.

A warning message will appear if too large a figure is entered.

5.4.1.1.2. Legend Selection

This section determines which Legends are to be printed. The following options are available.
All
This is the default option when printing. When selected, All Legends in the current Product will be printed.

Selected
This is only available if Legends are selected (see Mouse Operation on how to select Legends). When selected only the selected Legends will be printed.

Range
This allows a group of Legends to be printed. When enabled the following options are available:

- Legend #
  This allows the user to specify a From and To Legend number Range.

- Marker #
  This allows the user to select an individual marker position from within the To Legend # and From legend # range.

- Start Row
  This option is available for the Epson LQ when the Product is either in a sheet or wide-format Sleeve Product. This is the Start Row of the current page, on which the first Legend is printed.

  WinTotal can then calculate how many more rows are on the Product before a new Product needs to be loaded by the printer.

- Start Column
  This option is available for the Epson LQ printer when the Product has more than one column of Product per row. This is the Start Column that is used to Print the first Legend.

5.4.1.1.3. Port

This section lists the available Printer ports. The default selection is based upon the value in the Printers tab of the System Setup screen, but can be changed if required. If the required one is not visible please refer to the Printer Support topic.

5.4.1.1.4. Copies

This section contains the copy options:

- Number of Copies
  This option allows the Number of Copies to be entered. This is the number of times the Legends are printed based upon the Legend Selection options.

- Collate
  This option determines the order in which the Number of Copies will be printed.

5.4.1.1.5. Options

The Options button will show and hide the Print Options. These options will vary depending on the selected printer and Product combination.

- Leading Zero’s
  This refers to how Serialisations will be printed. The selection will Print a zero to the left of any number that does not fill the field.

- Mirror Print
  This option has two different functions depending on the Product.
- Scored Product will mirror the data between the different scores.
- For non-scored Product the forward slash (/) can be used to indicate the separation of fields and the mirror point.

Reverse Line Order
This will Print multiple-lined Legends with the Lines in reverse sequence.

Reverse Print Order
This option reverses the order in which the Legends are printed.

Print Back Side
This option has two different functions depending on the Product.

- If a Double-sided Product is selected it will Print the data from the Back Side.
- On a Product that is not double-sided, it will Print the Font data, but in a different way. This option varies by printer and can either reverse the Print order of the Legends or rotate the Legends 180° at Print time. This means that the way the Product is loaded into the Printer to Print the reverse side will vary between the first Legend and the last Legend.

Note: To change the reverse-side printing options to be the same as the front side, select the Print Front As Back option in the Printers tab of the System Setup screen for the required printer.

Print Strikes
This option allows some Compatible Printers to specify how many times the Print head passes over the Product to give a dark mark. A minimum of two should always be used unless printing on labels. Saved Parameter.

High Energy
This option is available only on the T312M printer and Compatible Products to give a higher energy value to the Print head, thereby giving improved mark performance. Saved Parameter.

Half Speed
This option is available only on the T312 printer and Compatible Products when High Energy is selected. It slows the printer down by half to help give even further improved mark performance. Saved Parameter.

Print Both Sides
This option is available only on the T612M DS, T6112DS and the LMS9000 laser. It enables both sides of a Legend to be printed at the same time.

Copy Front Side Data to Back Side
This option is available only for the LMS9000 laser. This duplicates the data on the Front side to the Back side at Print time.

Rotate 180
This option rotates the printing of the Product by 180° from its original orientation on Compatible Printers.

Speed
This option is available for some printers and is used to configure the Speed that the printer runs. The values available are dependent upon the current printer and the Units value set in the Options tab of the System Setup screen.

Note: If the value Printer Default is selected, then the Speed configured in the Printer will be used.

Density
This option is available for Compatible Printers and is used to configure the darkness. The values available are dependent upon the current printer.
Increasing this value will increase the darkness of the Print. Lowering this value will lighten the Print. The default values are configured depending on the selected Product and Printer combination. Only adjust these values if the quality is not acceptable.

Note: If the value Printer Default is selected, then the Print Mode configured in the Printer will be used.

Cutter Options
This option is enabled for Thermal Transfer Printers, which are either fitted with, or have the option to have, a cutter. When a compatible Product and Printer combination is available, the following cutter options are available.

Never
This option will not cut when the Product is printed.

Every
This option will cut after every Legend is printed.

Batch
This option will cut at the end of every Print batch.

Perforate
Available only on the T2000CT and T6112DS Printers. This will make the cutter change from cutting through the Product to only perforating it.

5.4.1.1.6. Sensor
This option is enabled for some Compatible Printers and can be used to switch the Sensor type being used by the Printer. The recommended sensor type is automatically selected based on the Product, but if required can be overridden.

Note: If the value Printer Default is selected, then the sensor type configured in the Printer will be used.

When the Print screen options are configured correctly, selecting OK will begin the Print process.

Once selected, the first Legend will Print and the First Marker Printed screen is displayed unless the Stop After First Marker Is Printed is not selected.

Note: On the T612M and T6112DS Printers this process is not allowed. When the OK button is pressed all Legends are printed.

Print First Marker Again
This will allow the first marker to be re-printed each time this option is selected. This is useful to check if the data on the Legend are in the correct position and using the correct options before printing the remainder of the data.

Continue to Print the Rest
This will Print the 2nd Legend to the last Legend.

Abort Printing
This will quit the First Marker Printed screen and return to the Print screen. This option should be used if the values required to achieve the correct output needs to be changed or the printing aborted.

5.4.2. Manual Print
This option will open the Add Product screen.

This option is designed for creating Legends that DO NOT REQUIRE SAVING.
Accessed from:

- Print… Manual Print menu
- Manual Print button on the Toolbar
- Manual Print button on the right-hand side of the screen

Once the Product has been selected the program will display the same functions as in the Add Data screen. There are some additional options:

5.4.2.1. Screen Options

Clear Data
This option deletes all data from within a Product, leaving the user to enter new data at Legend 1.

Change Product
This option allows the user to change the specified Product to a different one.

Exit Data Entry
This quits the data entry mode but not the Manual Print. This allows for editing and data manipulation to take place without loss of data.

Quit Manual Print
This quits the Manual Print mode. All existing Manual Print data will be lost after selecting Yes to the warning message.

5.4.3. Advanced Print

This option will open the Advanced Print screen.

Accessed from:

- Print…. Advanced Print menu
- Advanced Print button on the Toolbar

This screen allows simultaneous printing to several Printers as well as batched printing from several different files to a single printer.

Correct Printer and Product configurations must be made in the Printers tab of the System Setup screen prior to using this screen.

5.4.3.1. Screen Options

5.4.3.1.1. Selection Method

There are three different methods of selecting both Sets and/or Product to be printed.

Select Product(s) from Single Set
This option will display all existing Sets in the current Data Directory. The required Set can then be selected. A list of the Products in that Set will be listed.

One or more of the Products can be selected. To select a different Set, re-select this first Print mode. If the Set to be printed isn’t in the current Directory, select the Sets Directory button to change the Directory.
Select Complete Sets
This option will display all existing Sets in the current Data Directory. Sets can be selected (highlighted) by using the mouse and either CTRL or SHIFT buttons to select multiple items. All Products in selected Sets will be printed.

Search for Product(s) in all sets in data directory.
This option will display a screen similar to the AddProduct screen. The Product combination to be searched for can then be created. The Font, Lines and Colour selections can be ignored by selecting the **** in the top of each item if required. Multiple Products can be added if required. Only Sets containing one of the Products will be displayed.

Sets can be selected (highlighted) by using the mouse and either CTRL or SHIFT buttons to select multiple items. Only selected Products within selected Sets will be printed.

The Product options below can be used to modify the search criteria.

- New
  Additional Products can be included in the selection.
- Change
  This option allows the user to change the Product used for selection.
- Delete
  This option allows the user to delete the Product used for selection.

Select all
This will select all items that have been searched for.

Unselect all
This will unselect all items that have been searched for.

Add to Print Queue
This adds any selected (highlighted) items to the Print Queue.

5.4.3.1.2. Print Queue

This is the queue of items that will be printed. It is also the order in which the items will be printed.

The Print Queue items can be reordered by using the following buttons:

- Move to Start – this will move a single selected item to the beginning of the Print Queue.
- Move Up – this will move a single selected item up one position in the Print Queue.
- Move Down – this will move a single selected item down one position in the Print Queue.
- Move to End – this will move a single selected item to the end of the Print Queue.

5.4.3.1.3. Selection

- Load Last Saved Queue
  This option is used to recall the last Print Queue, if it was saved via the Save Print Queue button.
Save Print Queue
This option will save the selections placed in the Print Queue without printing them. The selections can easily be selected at a later time by pressing the Load Last Saved Queue button.

Delete
This option allows the user to remove any selected items in the Print Queue.

Print by Set
This option will print the data as per the Print Queue. That is the first Set in the queue, with the first Product within that Set, then the second, third etc. Then the second Set in the queue, first Product, second Product etc.

Print by Product
This option will print the data in the order by Product. That is the first Set in the queue, with the first Product, then any other Sets with the same Product (including colour). Then the second Product and all others with the second Product will be printed, and so on. This means that if one printer has many Products assigned to it, minimal loading and unloading of Product will occur.

Reverse Queue Order
This option reverses the order of the Print Queue.

Print
Once the Print Queue contains the desired Products, press this button to begin the printing process.

The Options button will show and hide the Advanced Print Options.

Separator Legend between Products
This option will print a complete row of markers filled with the asterisk character (*) between different Products and Sets. This can be a useful identifying marker for manually cutting batches of files when printed in one large Print run.

Pause between Products
This option pauses the printing between Products within Sets and gives the user a prompt to load the Product and make sure s/he has loaded the correct Product.

Stop after First Marker is Printed
This option will give a Print prompt for printing the first markers or continuing to the first Product in the Print Queue or all Products if Pause between Products is enabled.

Reverse Print Order
This option reverses the order in which the Legends are printed.

Print Back Side
This option prints the reverse side of the Legends. See the Print Back Side section in the Print topic.

Mirror Print
This option will mirror either the text or scores. See the Mirror Print section in the Print topic.

5.4.4. Print Preview
This option will open the Print Preview screen.

Accessed from:
- Print….Print Preview menu
• Advanced Print button on the Toolbar
• Print Preview button on the right-hand side of the screen

Here a Print Preview of the Product to be printed is shown.

5.4.4.1. Screen Options

First
This will display the Print Preview from the first Legend.

Next
This will display the next screen to be previewed if the number of Legends cannot be shown at one time.

Previous
This will display the previous screen to be previewed if the number of Legends cannot be shown at one time.

Last
This will display the last screen of Legends to be previewed.

Print
This will open the Print dialogue for the Product to be printed.

5.4.5. Paper Report

This option will open the Paper Report screen.

Accessed from:

• Print….Paper Report menu

This will produce a report that can be printed on sheets of paper or Continuous paper. It will show the Legend Data for the currently Selected Product, not all Product listings in Sets with multiple Products. To print all data for a Set with multiple Products, each Product must be selected and the Paper Report selected for each one.

5.4.5.1. Screen Options

Report Output Method
This option allows the user to specify the output for creating the Paper Report. The options are:

Windows Printer
This will send the data to a Windows Printer that will be selected once the Print button is pressed. This is for printing to ink jet and laser printers. These can be local or networked.

File/Raw Data
This will send the Raw data to either a Printer Port defined in Windows, or a file. When selected the following options are available.

Page Length
This is used to specify the Page Length in lines.

Output Port or File
This is used to specify the Printer Port, to which to send the data. It is also possible to type in a path and filename for output to a text file.
Some Printers require a form feed command to eject the paper from the Printer after the Paper Report is printed.

5.4.6. Print Log

This option will open the Print Log screen.

Accessed from:

- Print….Print Log menu.

This option is enabled in the Options tab in the System Setup screen.

Selecting any line within the log allows that record to be deleted.

5.5. Preferences

This contains the following options:

- System Setup
- Application Look
- Zoom In
- Zoom Out

5.5.1. System Setup

This option will open the System Setup screen.

Accessed from:

- Preferences….System Setup menu
- System Setup button on the Toolbar

This screen is where all default configurations are made using one of the following tabs:

- Printers
- Directories
- Options
- View
- User Access
- XMT Import Server

5.5.1.1. Printers

The Printers tab of the System Setup screen is used to specify the Printer, Port and their parameters.
5.5.1.1.1. Screen Options

Default Printer
This is where the Default Printer can be selected. See Printer Support for more information on support printers.

Port
This is where the default printer port can be selected on typed in. See Printer Support for more information on printer ports.

Print Front as Back
This option will change the rotation and sequence of the printed markers.

When the fronts of the sleeves are printed, they will be printed in the sequence and rotation normally used for reverse-side printing, i.e. first to last, or last to first and right-side up or upside down.

The sequence and rotation varies by printer. See the Print Back-side option in the Print topic.

This selection is not enabled for the LMS9000 and T612M DS printers as these are double-sided printers.

Cutter
This option will be displayed if a printer is capable of printing. If a cutter is not attached to a printer, this option can be disabled to prevent an unsupported command being sent to the printer. Some printers will print in error if a cut command is sent and no cutter is connected.

Use Default Windows Printer
This option is available when the Windows Printer is selected. When enabled all printing sent to the Windows Printer will be sent to the default printer specified in the Windows Control Panel. If unselected, a prompt to select the Windows Printer will be shown when printing.

Copy Front Side Data to Back Side
This option is only available if the LMS9000 and T612M DS printer are selected. It will automatically copy the data on the front to the back.

Swap Scores on Back Side
This option is available only for the LMS9000 laser and allows the scores on the Back Side to be swapped for reversing the back-side data.

Condensed Font
This option is available only for the LMS9000 laser and allows for twice the data to be entered on to a Legend than normally allowed. This allows the LMS9000 laser to condense the font to fit the text.

The Advanced Printer Setup button will show and hide the Advanced Print Setup section.

This function is flexible and powerful in configuring multiple Printers for WinTotal. A virtually unlimited number of Printers can be assigned to different Products or Directories.

The Advanced Printer Setup has infinite possibilities in its configurations. This configuration is referred to as Multiple-application Port Printing (MAPP).

Assign Printer
The options below are available for adding and removing Printers to the Advanced Printer Setup section.

Add
Additional Printers can be included, by this option. This will display the Add/Change Printer screen.
Change
This option allows the user to change the selected Printer. The first Printer in the list cannot be changed using this option as it is the Default Printer. This will display the Add/Change Printer screen.

Delete
This option allows the user to delete the selected Printer. The first Printer in the list cannot be deleted as this is the Default Printer. Note: All values for this Printer will be permanently deleted.

The Add/Change Printer screen is used to configure additional Printers to the Default Printer. Multiple Printers can be configured to be used from WinTotal with different Products or directories being assigned to them.

The following Printer options are available. When a Printer is added it will appear in the Advanced Printer Setup section.

Print Front as Back
This option will change the rotation and sequence of the printed markers.

When the fronts of the sleeves are printed, they will be printed in the sequence and rotation normally used for reverse-side printing, i.e. first to last, or last to first and right-side up or upside down.

The sequence and rotation varies by printer. See the Print Back-side option in the Print topic.

This selection is not enabled for the LMS9000 and T612M DS printers as these are double-sided printers.

Use Default Windows Printer
This option is available when the Windows Printer is selected. When enabled all printing sent to the Windows Printer will be sent to the default printer specified in the Windows Control Panel. If unselected, a prompt to select the Windows Printer will be shown when printing.

Copy Front-side Data to Back Side
This option is only available if the LMS9000 and T612M DS printer are selected. It will automatically copy the data on the front to the back.

5.5.1.1.2. Assign Products
The options below are available for assigning a Product to the selected Printer.

Add
This will allow a Product to be linked to the selected Printer. This will display a screen similar to the AddProduct screen, allowing users to select the Line, Family, Type, Size, Derivative and Colour that can be used to further identify the Product. A group of Products can be printed by selecting the ***** option in the list boxes to designate ALL Sizes, Derivatives and Colours. When a Product is added it will appear in the Assign Products section of the Advanced Printer Setup section under the selected Printer.

Change
This option allows the user to change the assigned Product. This will display the Change Product screen.

Delete
This option allows the user to delete the assigned Product for a selected Printer.
Enable Printer Parameters
This will display the Printer Parameters screen, which allows Printer Parameters to be assigned to the assigned Product. These values will be the default ones used when printing the selected combination. When a Product has Printer Parameters enabled, the text Printer parameters enabled will be shown next to the selected Product and Printer combination.

Printer Parameters
The Print Parameters screen contains all Printer Parameters available to be configured for the Product and Printer combination. This screen will show similar options to that in the Print screen. Options available will be dependent on the Printer selected. See the Printer Support section for more information.

5.5.1.1.3. Assign Directory

The options below are available for assigning a Directory to the selected Printer.

Add
This will allow a Directory to be linked to the selected Printer and Printer combination. This will open an Open screen where the required Directory can be selected. When a Product is added it will appear in the Assign Directory section of the Advanced Printer Setup section under the selected Printer.

Change
This option allows the user to change the selected Directory from an Open screen.

Delete
This option allows the user to delete the assignment of a Directory to a Product and Printer combination.

5.5.1.2. Directories

The Directories tab of the System Setup screen is used to specify default file locations. All locations can be changed by selecting their corresponding Browse button.

5.5.1.2.1. Screen Options

Data Directory
This is the default location of the Set files. This Directory must be available for all users who wish to use the program.

Import Files Directory
This is the default location used for data files used in the Import screen option.

Graphics Directory
This is the default location used when using the Graphics option in the Advanced Label Fields menu.

Database Printing Directory
This is the default location of the Job used in the Database Printing screen.

5.5.1.3. Options

The Options tab of the System Setup screen is used to configure the following options.
5.5.1.3.1. Screen Options

International

Language
This option is used to determine the language in which the WinTotal screens are to be displayed. Languages available are:

- Deutsch (German)
- English
- Espagnol (Spanish)
- Italian
- Nederland (Dutch)
- Norsk (Norwegian)

System 90 Products Supplied From
The Products from either USA or Europe differ for the System 90 Product. If the Product required can't be found, try changing the option.

Units
This option will display dimensional values in mm or inches.

Start with Last Used Set
Enabling this option will cause the last used Set and Product to be displayed when WinTotal starts.

Save Using WinTotal v98-v4.x Format (.set)
This option, when enabled, will default all Sets to be saved in the SET format. If unselected the WDF file format will be used (recommended). See the Sets section of the Data Management/Back-up topic for more information.

Show About at Start-up
Checking this option shows the About dialogue box each time WinTotal starts. This display can also be invoked using the About Software option in Help.

Confirm Program Exit
This option, when selected, displays a warning prompt when exiting WinTotal, requiring users to confirm exiting the software.

Edit Order: Down-Across
This option changes the way data are input on scored Products. See the Data Entry Order topic for more information.

Log Printed Markers
This creates a log of all printed markers. This log can be accessed via the Print Log commanding the Print menu.

Stop After First Marker is Printed
This option will set the default state for the Stop After First Marker is Printed option in the Print and Advanced Print screens. When enabled the first marker is printed and a screen is then displayed to allow the reprint of the first marker or to continue to print the rest of the markers. By default this option is on. This option can be changed in both the Print and Advanced Print screens, but the default state is controlled from this control.

Note: The following printers do not support this feature as the print job must be sent to a single job. For these printers the option is greyed out and ignored:

LMS9000, ITS BTT-02, T6112DS, T612M and Windows Printer.
Do not Feed Blank Sleeves after Printing Continuous Sleeves
This option, when enabled, will stop empty markers being fed after a print job is sent for Continuous Sleeve products when cutting or perforating.

Cancel to Exit Import Screen
This option leaves the Import screen open after a file is imported. If unchecked the Import screen closes automatically after an Import.

Serialisation Characters
This option allows the user to change the default Number (Numerical) and Letter (Alpha) Serialisations characters.

5.5.1.4. View

The View tab of the System Setup screen is used to configure all options related to display and view options.

5.5.1.4.1. Screen Options

Selected Product
This section is used to configure the columns available in the Selected Product list box in the main WinTotal screen. A ticked item will enable it to be shown in the Selected Product list box. The order of these columns can be changed by selecting a Column item and using the Move Up or Move Down button to move it to the desired location.

The Defaults button will select the following fields in the order below:

- Name
- Lines
- Size
- Font
- Printer
- Colour
- Markers

Enable Print Preview for all Products
This option allows a Print Preview option for all Products.

Show Continuous Tubing Products Horizontally
This option will display Continuous tube Products horizontally. These Products are only available for the T2000CT and T6112DS printers.

Show Toolbar
This enables or disables the Show Toolbar (see Toolbar topic for more information).

5.5.1.5. User Access

The User Access tab of the System Setup screen is used to configure the default options for user access.

This screen allows the default options for Minimum Level and Medium Level passwords to be customised from their defaults.

5.5.1.6. XMT Import Server

The XMTImportServer tab of the System Setup screen is used to configure WinTotal to act as an XMTFiles server.
This allows WinTotal to monitor for new XMT files. Once detected it will Import then Print it without saving any data into WinTotal.

5.5.1.6.1. Screen Options

Enable
This option turns the XMT Import Server on and off.

Minimise to System Tray
This will minimise WinTotal to the system tray when using the minimise icon in Windows. Once enabled it will remain minimised each time WinTotal is re-started. The program can be maximised by right clicking the WinTotal Icon and selecting Maximise WinTotal. The XMT server can also be stopped by clicking Stop XMT Server.

Disable All Fields in Print Screen
If selected when the Print screen appears all options will be disabled. All values must be configured in the Advanced Printer Setup option in the Printers tab of the System Setup screen.

Delete XMT File after Import
This option will Delete the XMT file as soon as the Product is printed.

Move XMT File to Specified Directory after Import
This option will move the XMT file as soon as the Product is printed to a specified Directory.

Directories
The location of which Directory WinTotal will monitor and the location of where printed XMTs will be placed can be viewed and changed in the Directories area by either using the Browse options or typing the path in manually. Entering a Directory that does not exist will create a new one.

5.5.2. Application look

The Application Look menu will display the different colour schemes in which WinTotal can be displayed.

5.5.3. Zoom In

The can be used to zoom in the WYSIWYG view of a Product. These settings are saved for each Product within a Set.

5.5.4. Zoom Out

The can be used to zoom out the WYSIWYG view of a Product. These settings are saved for each Product within a Set.
5.6. Help

This contains the following options:

- Help topics
- About Software
- Show Mouse Operation Help
- Software Registration

5.6.1. Help Topics

This will open this file.

5.6.2. About

This screen shows the About screen where information about WinTotal is displayed.

5.6.3. Show Mouse Operation Help

This will open the Mouse Operation topic of this file.

5.6.4. Software Registration

This screen is only available if the program is not registered. See the Software Licensing topic for more information.

6. TE CONNECTIVITY TECHNICAL SUPPORT

If you experience any technical difficulties using the program, the first thing to do is to refer to the on-line help.

If the supplied documentation does not solve the problem contact the vendor from whom you purchased WinTotal.

You can contact TE Connectivity Technical Support for any further assistance using the contact details below:

Global Email Support
Ident.tech.support@te.com

United Kingdom
United States of America
Ireland
Australia
New Zealand

Web Site Links
http://www.te.com/products/identification-labelling